
DocOrigin 3.3.007.01                                                        24-March-2025 
 
Merge 

• Fixed bug in Auto-generate test data when initial value is longer than approximately 1000 
characters or more. 

• Improved the Merge Log message when "Allow Split" is off to display the path where the 
object(s) cannot split. 
 

Scripting 
• Added Unicode support to _file.zip/unzip functions. See _file.zip 

 
FilterEditor 

• Fixed rare issue when string parameter (like “.00”) was incorrectly considered a number on save 
operation, causing an error on the following XFilter opening. 

 
Other 

• Added JDEConverter tool to the setup. 
• Expanded Chunkify tool command line options and added support for $ String Substitutions. See 

Chunkify tool 
• Updated Samples supplied with the setup. 
• Updated .NET Framework requirements from 4.5 to 4.6. 

https://docs.docorigin.com/reference-manual/scripting/script-functions/_file-read-write-files/_file-zip
https://docs.docorigin.com/reference-manual/chunkify-tool


DocOrigin 3.3.006.01                                                        21-January-2025 
 
Design 

• Added Tags docking pane. 
• Updated docking pane icons. 
• Added new currency formatting picture template. 

 
Merge 

• Improved logging for image processing errors. 
• Improved data merging algorithm by fixing anomalies when the parent data node replaced a 

field value with an empty string, which had previously been given its value via the “bindData” 
tag. 

• Introduced “NoStretch” Tag and Merge option to disable automatic vertical stretch of the 
objects. See -noStretch 

• Removed redundant empty lines in the EML HTML layout. 
• Improved the visual appearance of the auto-generated sample data for the Form. 
• Fixed a rare issue when Pane could fall beyond the Container bounds. 
• Enabled optimization for multi-column panes processing. 
• Fixed a bug in PDF: the URL text with spaces caused the following characters to be blue. 
• Fixed an issue causing redundant empty panes to be inserted.  
• Fixed issue in _file.copy() function when copying to “prt::” did not support forward slash. 
• Extended option -showNames to display a name without a full path. See -showNames 
• Added option -showXATWnames. See -showXATWnames 

 
FormConvert 

• Fixed the issue when two PRTs could be loaded simultaneously in the Design. 
• Improved the gray shades conversion to better match the Adobe Designer colors. 

 
FilterEditor 

• Improved usability: keep “OR” mode for new Test items if the user chooses to use “OR” for the 
Rule. 

 
Other 

• Setup: Updated DO Samples. 
• Updated Default-Paths.prm - changed $S from $U/Forms to $U/Scripts. 
• Setup: Removed some old unused PRTs. 

https://docs.docorigin.com/reference-manual/merge/command-options-merge/nostretch
https://docs.docorigin.com/reference-manual/merge/command-options-merge/shownames
https://docs.docorigin.com/reference-manual/merge/command-options-merge/showxatwnames


DocOrigin 3.3.005.02 HotFix                                            14-October-2024 

Merge 

• Fixed an issue where multiple output files were generated when using the “prt::” or “file::” 

prefix with the “-combineDocuments Yes” option. 

FolderMonitor 

• Resolved a rare issue that caused an unexpected exit when logging at the “-logSeverity ERROR” 

level.  

• Improved file operations stability on unstable networks by introducing two options  

“-fileOperationsRetryCount” and “-fileOperationsSleepTimer”. See: 

https://docs.docorigin.com/reference-manual/foldermonitor/command-options-foldermonitor  

 
 
 
 
 

https://docs.docorigin.com/reference-manual/foldermonitor/command-options-foldermonitor


DocOrigin 3.3.005.01                                                        15-August-2024 

Design 

• Fixed bug when the Locale goes off the screen.  
• Added ability to auto change Split option for all parent objects.  
• Improved Script Dialog by adding “Comment/Uncomment All” script buttons in Script Editor and 

Script Overview window.  
• Improved matched nodes highlighting in Data Explorer.  
• Improved font matching for better WYSIWYG experience for ZPL fonts.  
• Improved Line object selection experience with the lasso technique.  

Merge 

• Extended licensing information output on no-parameter Merge run.  
• Fixed unexpected exit in SendMail in sequential SendMail executions.  
• Improved ^form handling by ignoring quotes in its value.  
• Fixed bug when image is not shown in some email client.  
• Fixed unexpected exit in PDFExtract in some cases like page count.  
• Added File Name Placeholder processing for -EMLoutputfile option.  
• Improved RTF text embedding for plain text Labels.  
• Implemented the -embedPlainTextAsRtf for [!Profile xxx].  
• Improved stability on image processing while parsing not fully valid JPEG.  
• Improved text positioning for ZPL by making “-textPresentment 1” by default in ZPL 

Configuration files.  

FormConvert 

• Embedded DeMargin External tool that always removes Pane margins and repositions objects 
accordingly.  

• Improved processing of embedded fields related to appearance of the redundant #floatingField 
fields in the output XATW.  

• Improved algorithm by moving all objects located outside Page to the Page and setting the 
"visibility" to NONE.  

• Add functionality to remove "global_" or "group_" prefixes from embedded global fields.  

Configuration Editor 

• Fixed issue when some fonts are checked in the font list by default. 

Other 

• Added Chunkify.exe to the Windows setup. 
 



DocOrigin 3.3.004.01                                                        16-February-2024 

Design 

• Added a new dockable window for Scripts. 
• Improved visualization of Visibility=Invisible labels. 
• Fixed image visualization issues when using alignment commands. 
• Restored justification functionality of TextLabel.xml and M_TextLabel.xml. 
• Applied fix to keep current tool selected even after failed application (AutoField Tool). 
• Fixed inability to remove OnSplit Footers in some cases. 
• Fixed artifact when moving object with negative coords with arrow keys. 
• Added warning MessageBox when Pane's minHeight exceeds the Container height. 
• Fixed PDFPreview to support Unicode characters in a file path.  
• Fixed "Use PDF as Template" in Design to support Unicode in a file path.  
• Fixed object jumping while dragging on the canvas. 
• Deactivated Locale button for Labels of type Image and Text. 
• Fixed a PDF Preview bug when a datafile path contains the parent directory reference using two 

dots (..). 

Merge 

• Overhauled Stitching functionality with Duplexing. 
• Improved the Globals search algorithm when working with BindData, InitialValue and values set 

via Scripting. 
• Fixed processing when the form path contains Unicode characters. 
• Added a log Warning when the Pane minimum height exceeds the Container height. 
• Improved stability while working with partially incorrect TIFF images. 
• Fixed line duplication when “-printInDocumentOrder” is set to “Yes”. 
• Added a log Warning if no documents were generated. 
• Fixed ZPL driver incorrectly segmenting strings with URL while “-TextPresentation 1” option set. 
• Fixed wrong printer name (LJ4) for Default-PCL5(Color).prt files. 

FolderMonitor 

• Fixed broken log portion extraction (to the Error folder) if data file processing failed. 
• Fixed processing of data files without extension in some cases. 

FilterEditor 

• Fixed crash when user cancels out of the New Action Step dialog. 

Other 

• ConfigEditor: Allowed user to create a page size with a 1-inch measurement (Height or Width) 
for any PRT type. 

• Windows Setup: Updated Curl to v.8.4.0. 
• ConfigEditor: Fixed font listing with "Regular" keyword in its name. 



• Design and FilterEditor: Introduced a PRM option (-DataFileFilter) to add additional data file type 
filters. 

• FormConvert: Always set Min Height to .001''. 
• FormConvert: Move all objects outside the page bounds to the page and set Visible=none. 
• Linux and AIX Setup: Added Default-PCL* PRTs. 



DocOrigin 3.3.003.01                                                        1-September-2023 

Design 

• Added message which proposes using a recovered form version from the AutoSave folder when 
applicable. 

• Fixed Preview errors when the current folder contains custom files with the extension “.prt”. 
• Removed remnant "*" mark on the OnSplit Headers/Footers buttons in some cases.  
• Removed redundant Undo action from OnSplit Headers/Footers when user selects OK despite 

no changes being made. 
• Fixed Pane size calculation when Container with margins is resized. 
• Returned missing Finalize, PDF Input, and HTML Input script events to script dialog.  
• Fixed multiple barcode drawing artifacts. 
• Disabled justification and underline formatting actions for barcode objects. 
• Added DesignVersionCreated and DesignVersionModified values to XATW on New/Save 

operations. 
• Fixed Undo/Redo actions of Group layout changes to include child object positioning. 
• Fixed incorrect coordinates in the status bar while banding (click and drag). 
• Improved available space check for newly inserted Panes and reduced number of errors shown. 
• Fixed issue where QR code tag changes were not reflected in Design. 
• Added selected objects count to the status bar. 
• Updated UI icons. 

Merge 

• Added a new command line option (-spoolerJobOwner) to control the spooler job owner name. 
See https://docs.docorigin.com/reference-manual/merge/command-options-
merge/spoolerjobowner 

• Fixed issue when redundant footer was inserted at the end of the column. 
• Fixed issue when BindData tag reuses object value if not found in multiple document case. 
• Improved Global Field search algorithm to find values set via BindData tag. 
• Fixed issue when _dataSource was set only for the first instance of the Global Field. 
• Fixed pagination algorithm not to ignore Container bottom margin. 
• Fixed issue when redundant empty Container was added if the form contained a single 

columnarized Pane. 
• Fixed unexpected exit when using %f or %F in the -output. 
• Fixed issue with incorrectly aligned text under some barcodes. 
• Fixed incorrect auto-ratio (0) for barcode Code11. 
• Fixed incorrect generation of barcode GS1-128 checksum in some cases. 
• Fixed value leak for barcode 2of5 if multiple barcodes of that type are used. 
• Fixed issue where the wrong text codepage for barcode Code128 was used when 

Barcode128CharacterSet tag was used. 
• Improved object specificity in logging messages. 
• Fixed “Summary” XML to use correct document tag name when input data contained custom 

document tag. 
• Fixed issue when using "-stretchFields Yes" caused lost text alignment. 

https://docs.docorigin.com/reference-manual/merge/command-options-merge/spoolerjobowner
https://docs.docorigin.com/reference-manual/merge/command-options-merge/spoolerjobowner


• Added -stretchFields tag. See https://docs.docorigin.com/reference-manual/merge/command-
options-merge/stretchfields 

• Fixed “*Select*” ability of the WIN driver. See https://docs.docorigin.com/reference-
manual/merge/command-options-merge/output 

Scripting 

• Fixed _logPrintf function to output Unicode characters properly. 
• Added log warning if XmlFile functions are used after .close() has been called. 

FilterEditor 

• Extended "Append" action step with concatenation and trimming sub-options. 
• Added multiple enhancements to the Action JavaScript code dialog. 
• Fixed issue with incorrect extraction in some cases when the data file has the first line empty. 
• Fixed issue with unexpected change to StoreAs value (in Rules) when adding a new item to XML 

tree. 
• Added "Remove empty nodes" option to the New Filter dialog. 
• Enabled Move Up and Move Down context menu items for Action steps. 
• Changed default operation of tests from OR to AND. 
• Added FilterVersionCreated, FilterVersionModified, FilterDateCreated, and FilterDateModified 

values to XFilter on New/Save operations. 
• Updated UI icons. 

Core 

• Added milliseconds to log timestamp. 

Other 

• Updated barcode options in ZPL PRTs, Default-Zebra.xatwlib and Default-Tags.json. 
• ConfigEditor: Added EML printer type so that now EML PRTs can be saved. 

https://docs.docorigin.com/reference-manual/merge/command-options-merge/stretchfields
https://docs.docorigin.com/reference-manual/merge/command-options-merge/stretchfields
https://docs.docorigin.com/reference-manual/merge/command-options-merge/output
https://docs.docorigin.com/reference-manual/merge/command-options-merge/output


DocOrigin 3.3.002.01                                                        31-March-2023 

Design 
• Introduced new Tags dialog with predefined tags list. Added dependency on .Net Framework 

v.4.5. 

• Increased custom line spacing (LPI) accuracy to 6 decimals (the exact microns). Removed 
duplicated line spacing control from modal font dialog. 

• Added “*.txt” filter to PDFPreview’s select data file dialog. 

• Fixed search for "Each Script within the Form" to go through all scripts instead of showing only 
the first script found. 

• Fixed font size sorting in the toolbar for "hardcoded" 3-digit-wide font sizes. 

• Fixed cursor flickering on mouse move when an object tool is selected. 

• Fixed unexpected exit when an External Tool used in a custom toolbar (Tool 1-10) was removed 
from the Design.prm. 

• Fixed improper relocation of a newly added object in Groups with layout “flow top-to-bottom”. 

Merge 
• Fixed column balancing for a columnarized pane when it has a bottom margin. 

• Fixed bottom margin handling for columnarized pane on pagination. 

• Fixed height calculation for unbalanced columnarized pane in case of three or more columns. 

• Fixed layout calculation for unbalanced columnarized panes: 
o for the “force page” case. 
o for the case when break point before unbalanced columnarized pane is allowed.  
o for the case when common ancestor for unbalanced columnarized pane and following 

panes are too long. 

• Added header/footer height recalculation to use their real height on pagination. 

• Fixed pagination issue where footers and the bottom margins of split Panes were not considered 
when a new page is triggered by a “force page” pane setting. 

• Fixed unexpected exit when field content is a long string of characters with no spaces. 

• Added -stitchingFastCount option for PDF stitching. It is a switch between faster and more 
reliable ways to count external PDF’s pages. See https://docs.docorigin.com/reference-
manual/merge/merge-command-options/stitchingfastcount 

• Enabled PDFStitching to work when the XATW name has spaces. 

• Changed behavior on Windows to exit when “prt::” prefixed output fails instead of writing to a 
file. For backward compatibility added “-prtOutputRollbackToFile Y/N” option. See 
https://docs.docorigin.com/reference-manual/merge/merge-command-
options/prtoutputrollbacktofile 

• Fixed unexpected exit when _document.abandon() is used but no “-output” is provided. 

• Enabled “bindData” tag to handle names with dots, support bindData:* for fields with dotted 
names, and support bindData:"a.b" for quoted dotted names. See 
https://docs.docorigin.com/reference-manual/design/object-tags 

Scripting 
• Extended _file.copy() to support “prt::” prefix in “to” parameter. 

• Extended _merge(args) to support $ variables and heredoc. 

• Fixed unintentional decimal point (_system.setDecimal) reset to default by JavaScript filter and 
domObj.sum. 

https://docs.docorigin.com/reference-manual/merge/merge-command-options/stitchingfastcount
https://docs.docorigin.com/reference-manual/merge/merge-command-options/stitchingfastcount
https://docs.docorigin.com/reference-manual/merge/merge-command-options/prtoutputrollbacktofile
https://docs.docorigin.com/reference-manual/merge/merge-command-options/prtoutputrollbacktofile
https://docs.docorigin.com/reference-manual/design/object-tags


• Fixed unexpected exit when a script has a very long line.  

Folder Monitor 
• Changed wrong behavior introduced in v.3.2.001.11 so that now FolderMonitorTransaction 

writes to AtwTempFiles in Windows User Temp folder instead of DO/Bin by default. 

• Enabled “-cd” option to be used in DocOriginFolderMonitor.ini. 

• Enabled [DEFINE] section in DocOriginFolderMonitor.ini. 

• Fixed Linux samples by adding missing Sample_InvoiceJPS.wjs script.  

Form Convert 
• Fixed import of multiple images in cases where IFD or XDP have embedded and linked images 

and some are not found.  

FilterEditor 
• Added Find dialog to the Overlay window. 

• Fixed unexpected exit caused by changing the XML prototype when no XML prototype was 
originally set. 

• Replaced default "to" state called "* choose or type" with a new one called 
“LeaveOriginalState”. 

• Removed possibility to create empty-name XML nodes, instead name them 
"___MissingTag___". 

• Removed unwanted highlighting of non-leaf XML fields with the same name as a highlighted leaf 
field. 

• Enabled the AddAction menu item on the "When" condition inside the Rules view. 

• Enabled retention of “Rule-Extract to XML node” links when the XML Data Fields structure gets 
changed (like Drag&Drop). 

• Fixed selection highlighting issues. 

• Removed unwanted additional line transformation for “MaxLines to transform” setting. 

Core 
• Fixed unexpected exit caused by using “Profile” when there is a macro inside heredoc. 

• Fixed macro not expanding in profile if it followed another undefined macro. 

• Fixed return codes for processes started with _run, _merge, etc. on Unix.  

Other 
• Updated PDFProcessor’s 3rd party dependencies to avoid known vulnerabilities. 

 



DocOrigin 3.3.001.04 HotFix                                                 23-January-2023 

Merge 
• Fixed layout calculation for unbalanced columnarized panes  

o for the case when break point before unbalanced columnarized pane is allowed.  
o for the case when common ancestor for unbalanced columnarized pane and following 

panes is too long.  

• Added header/footer height recalculation to use their real height on pagination.  

• Fixed bottom margin handling for columnarized pane on pagination.  

• Fixed height calculation for unbalanced columnarized pane in case of three or more columns.  
Core 

• Fixed return codes for processes started with _run or _merge on Unix. 



DocOrigin 3.3.001.03 HotFix                                            23-November-2022 

Merge 
• Fixed layout calculation for unbalanced columnarized panes for the force page case. 



DocOrigin 3.3.001.02 HotFix                                            17-November-2022 

Merge 
• Fixed unexpected exit when field content is a long string of characters with no spaces. 

• Fixed column balancing for a columnarized pane when it has a bottom margin. 

• Fixed pagination for unbalanced columnarized panes. 

• Updated 3rd party dependencies for PDFProcessor to fix Apache Commons Text vulnerability. 
See https://cve.mitre.org/cgi-bin/cvename.cgi?name=CVE-2022-42889 

Scripting 
• Fixed unexpected exit when a script has a very long line. 

Setup 
• Updated the installer to show the full product version in the window caption.  

https://cve.mitre.org/cgi-bin/cvename.cgi?name=CVE-2022-42889


DocOrigin 3.3.001.01                                                     7-October-2022 

Merge 
• Added "-mergeCaseSensitive Yes/No" option to support case insensitive merge. 

See https://docorigin.com/doc/#option-mergeCaseSensitive 

• Added "-ellipsis Y/N" option to control ellipsis functionality. 
See https://docorigin.com/doc/#option-ellipsis 

• Added "-ellipsisCropLastWord Yes/No" option to append a portion of the last word before 
ellipsis. 
See https://docorigin.com/doc/#option-ellipsisCropLastWord 

• Added "-dataFileResults" option to specify a path to the file that will contain the exit code of 
each data file when processing multiple data files. 
See https://docorigin.com/doc/index.php#option-dataFileResults 

• Added "-AutoEmail Yes/No" option to make auto email functionality optional. 
See https://docorigin.com/doc/#option-autoEmail 

• Added "SupportAlpha", "TransparencyColor", and "TransparencyMask" to the list of valid 
command line options. 

• Implemented support for different "mediatype" for base64 encoded image data. 

• Fixed missing characters when "-showNames" and "-mode PDF/UA" are used together. 

• Made PDF security options configurable from command line and "Default-PDF.prt". 
See "Default-PDF.prt" for details. 

• Fixed MaxiCode barcode rendering when explicitly setting "MaxiCodeMode=auto". 

• Implemented auto module size calculation for DataMatrix barcode for ZPL output. 

• Allow embedded fields in tag value for Stitching. 

• Updated the list of valid command line options to include all barcode options. 

• Removed "OutputRedirect" message when the working directory is $E. 

Scripting 
• Added getters and setters for "blankback", "blankfront" and "blanktrailingback" properties. 

See https://docorigin.com/doc/index.php#domProperties 

• Added "No" option to "_printer.setPDFAllowChange" function. 
See https://docorigin.com/doc/index.php#_printer 

• Extended scripting for PDF Security. 
See https://docorigin.com/doc/index.php#_printer 

• Updated "_resolve" function to apply field formatting to embedded fields. 

• Enabled support for ECMAScript for XML (E4X) (ECMA-357). 
See https://en.wikipedia.org/wiki/ECMAScript_for_XML 

• Improved resolution of object names which match standard JavaScript classes, e.g. Number. 

Design 
• Added 10% and 25% zoom options. 

• Added copy path functionality to Form Explorer and Data Explorer context menus. 

• Improved fidelity of PDF Security dialog. 

• Improved persistence of custom colors in color palette. 

• Improved "Insert…" context menu items in Script Editor. 

• Updated Script Editor to support names with dots while using "Insert Object Reference". 

https://docorigin.com/doc/#option-mergeCaseSensitive
https://docorigin.com/doc/#option-ellipsis
https://docorigin.com/doc/#option-ellipsisCropLastWord
https://docorigin.com/doc/index.php#option-dataFileResults
https://docorigin.com/doc/#option-autoEmail
https://docorigin.com/doc/index.php#domProperties
https://docorigin.com/doc/index.php#_printer
https://docorigin.com/doc/index.php#_printer
https://en.wikipedia.org/wiki/ECMAScript_for_XML


• Fixed unexpected exit from Design on PDF preview of a newly created form if "Modify 
password" is set. 

• Deactivated linked fragment modification. 

• Fixed corruption of Unicode characters on RTF paste. 

Folder Monitor 
• Implemented configurable sorting of scanned data files. 

See https://docorigin.com/doc/#FMoption-sortingOrder 

Form Convert 
• Fixed unexpected exit when page size could not be found in the configuration file defined by the 

"-config" option. 

Filter Editor 
• Made all fields in filter properties editable. 

• Improved error reporting when opening a wrong file type instead of an "xfilter". 

Setup 
• Added a prompt to install FolderMonitor to DocOrigin installation. 

• Added "Default-TEC.xatwlib" to Linux and AIX installations. 

• Renamed "Default-Fragments.xatwlib" to "Default-AutoEmail.xatwlib". 

Configuration 
• Added PDF Security options to "Default-PDF.prt". 

• Added all barcode options to "Default-" PRT files. 

https://docorigin.com/doc/#FMoption-sortingOrder


DocOrigin 3.2.001.11                                                            29-June-2022 

Design 

• Fixed several high-resolution UI issues. 
• Fixed multiple-monitor mixed resolution issue. 
• Fixed undesirable auto-navigation for Objects larger than visible area of canvas. 
• Removed ability to edit Labels in Linked Fragments. 
• Fixed unintended renaming of Objects when navigating across multiple Forms. 
• Fixed crash when clicking “Script error” in the log if the error message is too long. 
• Fixed discrepancy between tab distance in Paragraph settings and rendered tab distance when 

tab distance is not set in the xatw. 
• Extended tabs in Paragraph settings to include "0.0 in". 
• Enhanced “Select Configuration File” dialog to remember last used PRT when opening IFDs, 

XDPs, or PDFs. 
• Fixed GUI display of objects with margins in groups with layout “Flow Top to Bottom”. 
• Fixed resizing of groups to fit all children when layout changed to “Flow Top to Bottom”. 
• Fixed GUI display of edges and line styles for Groups and Containers. 
• Implemented "Apply to all missing fonts" option in “Alternate Typeface Selection” dialog. 
• Fixed inaccurate Data Explorer field highlighting. 
• Implemented "Change Document Separator Tag" menu in Data Explorer. 

Merge 

• Implemented Code 11 barcode. 
• Improved logging. Added real placeholder name (not template) to error log in case this 

placeholder cannot be opened. 
• Implemented "MandatoryMatch Yes/No" (default “No”) tag for Panes and Groups. When “Yes”, 

the tagged object is required to participate in matching. 
• Fixed unbalanced columns when the wrapping pane is vertically shifted. 
• Implemented support of # as a comment in *.prm files. 
• Enhanced _fullName DOM property to support names with colons, periods, and hyphens. 
• Fixed PDF and PCL duplexing when mixing “Page placement” settings. 
• Deactivated PDF/UA mode for “CombineDocuments=Yes” case. 

FolderMonitor 

• Fixed incorrect behavior of DocOriginFMTransaction when the script is big. 
• Restricted DocOriginFMTransaction from unintentionally writing temp files to DO/bin when 

starting with -cd option. 

Scripting 

• Fixed _data._loadAsObject to handle multilevel and repeatable objects. 
• Enhanced _xml operations to create names containing periods, colons, hyphens, and 

underscores. 
• Enhanced XmlInput to process XML files without namespace declarations. 



FormConvert 

• Enhanced subform layout="lr-tb" (left-to-right and top-to-bottom) conversion. 
• Fixed inaccurate resultant negative width of rotated fields with “minH” attribute. 
• Improved XHTML to RTF conversion for labels.  

o Implemented support of "style" attribute for <p> tag. 
o Implemented support for non-quoted font name in "font-family:". 
o Fixed “font-size:” parsing. 
o Fixed font change detection in FormConvert.  

• Added handling for XDP attribute “justifyAll” as a synonym for “justify-all”. 
• Improved conversions for fields with captions. 
• Implemented page size name guessing by page dimensions. 
• Added tab distance of "0.5 in" to Labels and Fields if not specified in XDP. 
• Implemented "-setConfig Y/N" (default N) option to control setting a Form’s “configFile” 

attribute. 

ConvertDatToXml 

• Extended target field search from current pane’s children to all descendants. 

Other 

• Core 
o Improved printer related logging. Added error code descriptions where possible. 
o Improved logging if application of -cd option fails. 
o Fixed enumeration of files with special characters in name on Linux. 

• Default Files 
o Added Default-PCL5.prt and Default-PCL5Color.prt with adjusted page coordinates from 

legacy LJ4 PRT files to match PDF output. 
• DocOrigin Installer for Windows 

o Automated removal of FolderMonitor and QueueMonitor. 
o Added option to remove FolderMonitor and QueueMonitor services. 
o Added option to remove DocOrigin registry entries. 
o Deactivated possibility to change installation folder on upgrade. 
o Preserve accelerator keys on uninstall.  

• PDFProcessor 
o Updated Java libraries to avoid known vulnerabilities. 



DocOrigin 3.2.001.10                                                        18-March-2022 

Design 

• Fixed bug where the top or bottom object in a group of selected objects in Form Explorer was 
lost upon right clicking. 

Merge 

• Fixed the loss of paragraph information in rtf fields and labels when split on pagination. 
• Updated Merge to generate an empty page for PDF files only when there is no output in the 

resulting output file. 

Form Convert 

• Fixed $DATEnn and $TIMEn embedded field conversion for fields and labels. 
• Updated FormConvert to store the configuration file selected during conversion in the resulting 

xatw. 
• Updated FormConvert to set the Pagination Algorithm to Version 2 (strict) for converted forms. 

Configuration Editor 

• Grayed-out the duplexing option to more clearly indicate it is purely informational as opposed 
to configurable. 

• Fixed tree controls bug preventing item selection in some multi-monitor scenarios. 



DocOrigin 3.2.001.09                                                        04-March-2022 

Design 

• Fixed "Insert Object Reference" window position in the Script Dialog in multi monitor setup.  
• Fixed incorrect data file path evaluation in PDF Preview in some cases.  
• Added the option "Tools->Options->Align panes to grid". When "on", Design will extend panes 

so they always end on the grid. This way the following pane will also start on the grid making it 
easier for a user to align internal objects on the grid.  

• Fixed items duplication in Page Properties combo box after Apply.  
• Changed "Update all font substitutions into the registry" to be unchecked by default. 

Merge 

• Added support for Merge parameters in a data file PI. 
See https://docorigin.com/doc/index.php#ProcessInstructions 

• Fixed data merge when group order doesn't match data order.  
• Added "-LineBreak 0|1|2|3" option to control line break algorithm. 

See https://docorigin.com/doc/#option-lineBreak 
• Improved JSON data support. 

See https://docorigin.com/doc/index.php#DataFilesJSON 
o Implemented number, bool, and null values handling. 
o Improved array handling.  

▪ Each array item should end up as a separate node, not all merged together. 
▪ Empty array doesn’t create a node. 
▪ Added "_node" node for non named items, e.g. array elements. 

o Implemented the option “JsonInterpretNullAs” to replace null with some text. 
o Implemented the option “JsonNoNameNodeTitle” to rename auto name "_node" to 

something else. 
• Fixed extra new page triggering when splitting a Force Page pane with headers.  
• Fixed extra new page triggering when a Force Page pane is already at the top of the page but is 

shifted because of margins.  
• Implemented "BalancedColumns Yes/No" option to control column balancing. Default is Yes. 

When No, then columns are filled left to right, top to bottom. See 
https://www.docorigin.com/doc/index.php#Pagination:Layout%20in%20multiple%20columns 

• Changed image type recognition from a file extension test to the file header test.  

Form Convert 

• Improved handling of @$DATEnn in text labels.  
o Implemented conversion of embedded @$DATEnn to [!Date ...] in text labels. Note that 

other $VARIABLEs are still converted to xVARIABLEs for fields and embedded variables 
in text labels. 

o Fixed occasional line duplication when there is @$DATEnn in text labels. 
• Fixed undesirable opaque white background for labels with colored text.  

https://docorigin.com/doc/index.php#ProcessInstructions
https://docorigin.com/doc/#option-lineBreak
https://docorigin.com/doc/index.php#DataFilesJSON
https://www.docorigin.com/doc/index.php#Pagination:Layout%20in%20multiple%20columns


Scripting 

• Updated _document.serializeForm(). 
o Added result code. 
o Added file path resolution. 
o Fixed crash. 

• Changed unicode characters output from escaping format to characters themselves for complex 
objects in _logPrintf.  

• Updated locale formatCurrency, formatNumber, spellOut, spellOutCurrency functions to use a 
number if the input is originally a number and do text to number conversion only if the input is 
passed as a string. This allows users to avoid erroneous conversion in cases when 
_system.setDecimal has been used.  

• Added JavaScript _locale property to DOM objects which return a JavaScript _locale object (not 
a name). 
See https://docorigin.com/doc/#domProperties  

Folder Monitor 

• Changed %i for scriptFolder to be resolved on Folder Monitor start like other parameters.  

ConvertDatToXml 

• Made “-newline” command line option accept empty value.  

Configuration Editor 

• Added missing Bahnschrift (bahnschrift.ttf) font.  

https://docorigin.com/doc/#domProperties


DocOrigin 3.2.001.08                                                        22-November-2021 

Design 

• Fixed Script, Log View, etc. dialog windows position in multi monitor setup. 

Merge 

• Fixed page properties initialization for WinDriver. 

Scripting 

• Fixed folders matching when using wildcards in “_file.zip()”. 

Folder Monitor 

• Fixed resolution of "%" placeholders for "-scriptFolder" option. 
 



DocOrigin 3.2.001.07                                                        03-November-2021 

Design 

• Improved the lasso selection. 
• Added “Edit->Select All->Groups in Page” to the menu. 
• Added warning to Form Verification Report for automatic font style (bold/italic) substitutions 

when the exact font match is not found. 
• Allow automatic font style substitutions for fragments if the exact font match is not found. 
• Fixed crash on form save when image is inserted as a template. 
• Added “Collapse/Expand children” context menu item to Form Explorer. 
• Added “Format->Resize Panes to Minimum Height on Page” menu item. 
• Fixed repeated PRT selection dialog on IFD import. 
• Improved editing of merged cells and nested tables. 
• Updated the default pane template to use Job Section: “Main”. 
• Added warning on “Save As” action if the target file name already exists. 

Merge 

• Removed JSON data node size limitation for JSON input data file. 
• Made the object's name interpreted as the key for Auto Translate when the object’s 

TranslateKey tag value is “*”. 
See https://docorigin.com/doc/#AutoTranslate 

• Changed Auto Translate processing to be executed after the Start-of-Job event. 
• Added the host name (_HostName) in the session's metadata. 

See https://docorigin.com/doc/#Session 
• Improved auto-generation of JSON input data file. 
• Added “Underlay” synonym for “Placeholder” tag. 

See https://docorigin.com/doc/#MergeExternalPDFs 
• Added “-embeddedDefault” option to configure the default value for embedded fields. 

See https://www.docorigin.com/doc/index.php#option-embeddedDefault 
• Added new duplex page placement setting "Start on front, then either side". Supported by PCL 

driver only. 
• Added “-stretchFields” option to allow fields to stretch vertically with its parent pane. 

See https://docorigin.com/doc/index.php#option-stretchFields 
• Improved Merge error logging when using filters. 
• Added “%” placeholders support to "-filterOutput" command line option. 
• Fixed “%D” resolution to original input data file for cases when “-filter” was used. 
• Added “-emptyNodeInstantiatePane” option to control the creation of panes that match the 

empty node in input data. 
See https://docorigin.com/doc/#option-emptyNodeInstantiatePane 

• Changed embedded fields resolution order to search fields first and only then, labels. 
• Fixed XML escaping for “-embedData” for PDF driver. 
• Extended error logging for Merge error 58 (ERR_MERGE_PRINTDOCUMENT). 
• Added logging for Merge output destination. 
• Adjusted Zebra-H font character widths to better match the real output. 

https://docorigin.com/doc/#AutoTranslate
https://docorigin.com/doc/#Session
https://docorigin.com/doc/#MergeExternalPDFs
https://www.docorigin.com/doc/index.php#option-embeddedDefault
https://docorigin.com/doc/index.php#option-stretchFields
https://docorigin.com/doc/#option-emptyNodeInstantiatePane


Scripting 

• Added “[@fileName]” support in “_resolve()”. 
• Fixed input/output redirection handling, e.g. “>”, “<”, “|”,  and others, in “_run()” call. 
• Add wildcard support to “_file.zip()”. 
• Added an application name in the title of the “_message” and “_prompt” dialogs. 
• Made “_file.fopen()” and “_file.writeFile()” create folder hierarchy if open mode is “w” or “a”. 
• Added “_toXmlString()” and “_fromXmlString()”. 

See https://docorigin.com/doc/index.php#_toXmlString 

Filter Editor 

• Fixed incorrect item selection when clicking “XML Data Fields” in some scenarios when 
“AppendTo” was involved. 

• Added warning about possible mistakes when extracting multiple items into the same XML 
node. 

• Added possibility to produce multi-instance nodes within one parent node using the “M” option 
in the context menu. 

• Added “(NewDoc)” suffix to the rule name when its “StartNewDocument” property is “true”. 
• Removed “StartNewDocument” property for new filters. Use the “Start New Document” action 

instead. 
• Fixed field selection dialog not showing when clicking in “Store as Field” in Extract action in 

some rare cases. 
• Added “(No match)” prefix to all rule names with no matches against the data file. 
• Added undo/redo support to changes made in the string and drop down fields in Filter Rules. 
• Added undo/redo action descriptions to the menu items. 
• Changed the "From State" property to be a multi-selection combobox to make multiple choices 

more visible. 
• Set codepage to “UTF-8” when explicit SymbolSet is not specified in a filter. 
• Fixed accented letters not displaying properly in the Filter Rules. 
• Added “rules-matching” log for debugging the filter under “Tools->View parsing log” menu item. 

Form Convert 

• Made XATW form name the same as IFD file name. 
• Added ConvertIFDShell’s “fieldCorrection” option to FormConvert.  
• Embedded ConvertIFDShell output log into FormConvert log.  
• Improved parsing of embedded field references.  
• Replaced non-breaking spaces with regular spaces in text labels. 
• Improved handling of spaces and new lines for text labels. 
• Added rtf to plain text simplification when the target text label does not use formatting.  
• Added “-RetainSpaces” option to control spaces conversion for text labels. 

See https://docorigin.com/doc/#FormConvertoption-RetainSpaces 
• Added “-AdjustLabelWidth” option to adjust text label width during conversion. 

See https://docorigin.com/doc/#FormConvertoption-AdjustLabelWidth 
• Fixed handling of subform with explicitly set layout="position" in XDP.  
• Fixed handling of diagonal lines with slope="/" attribute in XDP. 
• Fixed handling of font sizes which are not full or half point sizes. 

https://docorigin.com/doc/index.php#_toXmlString
https://docorigin.com/doc/#FormConvertoption-RetainSpaces
https://docorigin.com/doc/#FormConvertoption-AdjustLabelWidth


Folder Monitor 

• Fixed failed job log file. 
• Improved FolderMonitor and FolderMonitorTransaction logging. 

SendMailServer 

• Added curlOptions support to SendMailServer on Linux/AIX. 

Setup 

• Fixed registry key in AllowOtherDocoriginUsers.bat.  



DocOrigin 3.2.001.05                                                                02-July-2021 

Design 
• Added support for unicode characters in Design log view. 

• Added object names validation on Form open. 

Merge 
• Fixed typo in TranslateKey implementation. 

• Improved scannability for barcodes in PDF output. 

• Fixed crash in dithering algorithm (image conversion to black and white) used in ZPL and TEC. 

• Fixed label/field split(pagination) failure when split occurs right after the empty first line. 

• Fixed radio buttons printing issue for Fillable PDF. 

Scripting 
• Fixed typo in getOpenFolderName() log message. 

• Fixed fp.fwrite(string, [count]) parameters validation. 

• Fixed crash on too long line in script. 

ConvertDatToXml 

• Fixed document split issue in case of non unique fields. 

FormConvert 
• Implemented a BMP image header fixup in some cases. 

• Fixed occasional pane order lost when converting from IFD. 

• Added object names validation according to DocOrigin rules in import post fixups. 



DocOrigin 3.2.001.04                                                                05-May-2021 

Design 
• Fixed Design initialization for the new user. 

• Fixed log view to highlight critical errors in red. 

• Fixed “go to” script by clicking on object name in the script error in the log view. 

• Fixed form name as a result of ifd or pdf convert in Design. 

• Added support for @prmfile in "Merge Options" in "PDF Preview", "Merge Test", etc. 

• Fixed crash when no fonts are found for selected configuration. 

• Keep object name as a result of "Format Field to Label". 

• Fixed used cursor in use when page object is selected. 

• Make form modified after successful run of an external tool. 

• Allow “-” and “.” in object names. 

• Fixed object’s colors update in some cases. 

Merge 
• Added a log message if there was no documentTag match. 

• Fixed crash when [!Data ...] references an empty data item on Unix. 

Scripting 

• Fixed crash when serializing objects with null properties. 

• Added _os.getHostname() script function. 
See https://docorigin.com/doc/#_os 

FolderMonitor 

• Added support for DocOriginFolderMonitor.ini on Unix. 

• Fixed FolderMonitor to use log file template, e.g. “-logfile %y%m%d.log“, when starting child 
processes on Unix. 

ConvertDatToXml 

• Fixed crash when doing substitute with newline injection. 

• Implemented support for long data fields. 

• Implemented support "-fragmentautoresolve Y/N" for linked fragments. 

ConfigEditor 

• Fixed bug in serializing some fields in a PRT file. 

FilterEditor 

• Fixed update for the selection of an extraction. 

https://docorigin.com/doc/#_os


Misc 

• Fixed Sample_Barcode.xatw sample to make it work for a clean installation. 

• Fixed DO script to prepend its library path before the predefined ones on Unix 
(LD_LIBRARY_PATH on Linux, LIBPATH on AIX). 



DocOrigin 3.2.001.03                                                                15-March-2021 

Merge 

• Allow numCopies to be driver specific. 
• Improved "PrinterOpenError" error message with failed path. 
• Added Merge options to control text vertical alignment on split of text labels and fields during 

the pagination process: 
o “-TextVerticalAlignmentMethodOnSplit 0/1/2/3” and 
o “-MinimizeTextObjectHeightOnSplit Y/N”. 

• Allow $$F and $$D to be used in the “-config” path. 

Design 

• Added configuration file selection dialog to form import. 
• Added a checkbox to “Update all font substitutions into the registry” in "Alternate Typeface 

Selection" dialog. 
• Added “View”->”Text Labels are Active” option to the main menu. 
• Added “DocOrigin\DO\Bin\ResetAllDesignMenus.bat” to recover menus and toolbars. 
• Added possibility to browse for Fragment Library files in any location. 
• Fixed text label update issue after exiting from editing mode by changing focus to Form 

Explorer. 
• Fixed chained filters for Design preview. 

Scripting 

• Added <domObj>._date and <domObj>._dateObj properties. 
See https://docorigin.com/doc/index.php#domProperties 

• Added <domObj>.getObjectsByTagValue(tagName, tagValue) function. 
See https://docorigin.com/doc/index.php#domObj_getObjectsByTagValue 

• Added <dataObj>.ancestor, <dataObj>.descendant, <dataObj>.childNamed. 
See https://docorigin.com/doc/index.php#_data 

• Added http.readyState and http.status to XMLHttpRequest.  
See https://docorigin.com/doc/#XMLHttpRequest 

• Fixed handling of a large response in http.responseText in XMLHttpRequest. 
• Changed XmlFile to emit an empty leaf node as <tag /> not <tag></tag>. 

QueueMonitor 

• Fixed DocOriginQueueMonitor to work from the command line. 
• Removed 25 max ports limitation in DocOriginQueueMonitorSVC. 

FolderMonitor 

• Changed JobID format. 

https://docorigin.com/doc/index.php#domProperties
https://docorigin.com/doc/index.php#domObj_getObjectsByTagValue
https://docorigin.com/doc/index.php#_data
https://docorigin.com/doc/#XMLHttpRequest


FormConvert 

• Added “-RetainSpaces Yes/No” option to FormConvert to control spaces compression in xhtml 
to rtf text conversion. 

ConfigEditor 

• Added support for more fonts. 

Email 

• Added SampleGmail_DocOriginSendMailServer.prm. 

FilterEditor 

• Improved user experience for FilterEditor UI. 
• Improved main view refresh speed for very complex filters. 
• Added *Start* to the From state dropdown. 
• Allow spaces in the comma separated list in From state. 
• Disallow comma separated lists in the To state dropdown. 
• Added new action step - “Append to Field”. 
• Added View->AutoSync option to automatically sync selected rule along with the currently 

selected XML Data Field. 
• Extended codepage selection in the following dialogs: File->New and File->Properties. 
• Added double click action on rule’s test items to open “Select action” dialog. 
• Added ability to drag-n-drop nodes in XML Data Fields view. 



DocOrigin 3.2.001.02                                                        19-November-2020 

Merge 

• Improved sample data (aka autodata) generation by Merge on Linux. 
See https://docorigin.com/doc/#option-createData 

• Added support for keys with space characters for JSON data. Space characters are now 
automatically converted to underscores. 
See https://docorigin.com/doc/#DataFiles:JSON%20Input 

• Added [!Field x] support to _file.resolveName(). 
See https://docorigin.com/doc/#_file_resolveName 

• Added support of [!Auto xxxx], e.g. [!Auto PageNum]. 
See https://docorigin.com/doc/#AutomaticAndEmbeddedFields 

• Added Email signing and encryption functionality. 
See https://www.docorigin.com/doc/index.php#SigningMail 

• Added encrypted PDF output support to external PDFs merging, aka “PDF Stitching”. 
See https://docorigin.com/doc/#MergePDFStitching 

• Added support of CheckBoxSize definition using field tags. See Default-LJ4.prt, Default-PDF.prt, 
Default-PS2.prt, etc. 

• Made PDFExtract process use the same log as Merge during placeholders processing. 
• Fixed automatic URL formatting for “TextPresentation=1” (line-at-a-time). 

See https://docorigin.com/doc/#option-textpresentation 
• Fixed an issue with simultaneous use of “-filter scriptA.wjs” and “-scriptFile scriptB.wjs”. 
• Fixed field height expansion on text overload when "Adjust height" is off. 
• Fixed auto “http://” prefixing for URLs that already start with “http[s]://” for HTML output. 
• Fixed script processing when the script in Form's Common Code has text that matches Merge 

events. 

Design 

• Improved Ctrl+Click object selection/deselection in FormExplorer. 
• Allow simultaneous selection of parent and child objects. 
• Allow empty labels on the Form. 
• Added “Options”/”Tools”->“Typefaces substitutions...“ menu item which allows managing the 

font substitutions within Design. 
• Added check for properties' pane changes on form close. 
• Added "Clip to height" checkbox in Label’s object properties. When enabled, the label does not 

grow in height, i.e., it shows full text in editor mode but clipped text otherwise. 
• Added “Edit”->"Select All"->"Panes in Page" menu item. 
• Added "Format"->"Align to Grid"->"Top, Left, Botto, Right" which first repositions the object, so 

its top left corner is on the grid and then resizes it, so its bottom right corner is on the grid. 
• Made Image Save Dialog remember last save location. 
• Do not allow invisible panes (Visible: None) to be selected as an object insert target. 
• Fixed grid tics turning into a solid black line when very fine grid or on large zoom out. 
• Fixed Design crash when previewing a form with a page without a name. 
• Fixed Pane’s children duplication when calling "Link Objects into Pane" for a single selected Pane 

object. 

https://docorigin.com/doc/#option-createData
https://docorigin.com/doc/#DataFiles:JSON%20Input
https://docorigin.com/doc/#_file_resolveName
https://docorigin.com/doc/#AutomaticAndEmbeddedFields
https://www.docorigin.com/doc/index.php#SigningMail
https://docorigin.com/doc/#MergePDFStitching
https://docorigin.com/doc/#option-textpresentation


• Fixed mouse pointer repositioning when clicking on zoom in/out buttons on the toolbar. 
• Fixed displaying of custom checkbox marks in Design, e.g., when CheckboxStyle is X. 
• Fixed undesired line resize after moving if the line's ends were not located on the grid. 
• Fixed unintentional fragments library deletion during AutoSave. 
• Fixed label growing beyond parent object borders on text input. 
• Fixed unintentional container's growth wide wise on child resize. 
• Fixed preview when Merge parameter without value is used. 

Scripting 

 
• Allow folder path to be used as a destination parameter in _file.copy(). 

See https://docorigin.com/doc/#_file 
• Made _file.toBase64() support binary files. 

See https://docorigin.com/doc/#_file 
• Added _runNoWait() function. 

See https://docorigin.com/doc/#_runNoWait 
• Fixed _file.findNext() for Linux when nameMask was too general, e.g. “*”. 

See https://docorigin.com/doc/#_file_findNext 
• Fixed _file.readFile() so it returns an empty string instead of null on an empty file. 

See https://docorigin.com/doc/#_file 
• Added logging error message in case of a temp file creation error in _runScript/_merge. 
• Added append mode to _file.writeFile(). 

See https://docorigin.com/doc/#_file 
• Added wildcard support to _file.exists(). 

See https://docorigin.com/doc/#_file 
• Added _file.getOpenFolderName() function for displaying dialog for folder selection (Windows 

only). 
See https://docorigin.com/doc/#_file 

• Fixed “som” property (dotted schema object model notation) calculation for XmlInput when 
there are tag names with dots. 
See https://docorigin.com/doc/#XmlInput 

• Changed return value in [RunScript:ScriptOK] message from int/string/boolean representation 
to the actual value. 

• Made _run() not issue an error message if it returns a non-zero return code. 
See https://docorigin.com/doc/#_run 

FormConvert 

• Introduced Default-FormConvert.prm file with predefined “-splitSegs No”. 
See https://docorigin.com/doc/#option-splitSegs 

• Introduced "ContainerShift" option to set the left and right shift of a container's border when 
importing. 
See https://docorigin.com/doc/#FormFileConversion:Batch%20Conversion 

FolderMonitor 

• Added log messages for ExitWhen or ExitNow events. 

https://docorigin.com/doc/#_file
https://docorigin.com/doc/#_file
https://docorigin.com/doc/#_runNoWait
https://docorigin.com/doc/#_file_findNext
https://docorigin.com/doc/#_file
https://docorigin.com/doc/#_file
https://docorigin.com/doc/#_file
https://docorigin.com/doc/#_file
https://docorigin.com/doc/#XmlInput
https://docorigin.com/doc/#_run
https://docorigin.com/doc/#option-splitSegs
https://docorigin.com/doc/#FormFileConversion:Batch%20Conversion


DocOriginNotify 

• Packaged DocOriginNotify and its DocOrigin dependencies into a zip archive.  
Note that you still may need to install Microsoft Visual C++ Redistributable for Visual Studio 
2017. See https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-
downloads 

Other 

• Fixed reporting of the number of fonts in a .ttc file by TTFUtil. 
• Fixed DocOriginSendMailServer crash when Windows-like path (C:\...) to the mail folders was 

specified by mistake for Linux. 
• Improved error reporting when DocOrigin filters fail to start. 

 
 

https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads
https://support.microsoft.com/en-us/help/2977003/the-latest-supported-visual-c-downloads


DocOrigin 3.2.001.01                                                               30-June-2020 

Merge 
• Extended set of embedded fields. See 

https://www.docorigin.com/doc/index.php#AutomaticAndEmbeddedFields 
o [!Data name] to fetch value from Data DOM.  
o [!Env name] to the value of the environment variable. 
o [!Field name] as an alternative to [name]. 
o [!Session name] to fetch data from the current Session. See 

https://www.docorigin.com/doc/index.php#Session 
• Automated language translation support 

o Added ~name label translation feature with -Translate and -Language command options 
added. See https://www.docorigin.com/doc/index.php#AutoTranslate 

• Including external PDF files 
o Added new Placeholder tag pattern to include all pages from external PDF - “pages=*”. 

It is default now if the "pages=" part is missing. See 
https://www.docorigin.com/doc/index.php#MergePDFStitching 

o Added automatic resolve for Placeholder tag value,  
i.e. values like: “$$F/[!Profile profKey1].pdf” will be processed properly. See 
https://www.docorigin.com/doc/index.php#MergePDFStitching   

• Miscellaneous 
o Added Direct Data Binding possibility. See “Direct Data Binding” section in 

https://www.docorigin.com/doc/index.php#DesignObjectTags 
o Added support for JSON input data. See 

https://www.docorigin.com/doc/index.php#DataFiles:JSON%20Input 
o Added -xxxDataExts command line option to set default filename extensions for 

different input data formats. See DO/Bin/Default-Merge.prm file. 
o Added -InputDataType command line option to indicate the input data format. See 

https://www.docorigin.com/doc/index.php#option-inputDataType 
o Made Merge to support SendMail command line parameters, allowing to override 

DocOriginSendMailServer.prm configuration. See 
https://www.docorigin.com/doc/index.php#SendMail 

o Added new command line parameter "-RestrictedFileNames Yes/No" to control 
conversion of file names with restricted chars. See 
https://www.docorigin.com/doc/index.php#FileNamingConventions 

o Improved performance when using (Default-)WIN.prt configuration file. 
o Added possibility to change a document’s locale on document-by-document basis. See 

https://www.docorigin.com/doc/index.php#_locale 
o Added PDF417 barcode to Zebra Internal barcodes. See Zebra Fragments. 
o Added "-embedPlainTextAsRtf Yes/No" option to control <EOL> to "\line" conversion 

when embedding plain text into rtf formatted text. Default is No. See 
https://docorigin.com/doc/index.php#option-embedPlainTextAsRtf 

o Added HighlightURL parameter to control formatting of email/http addresses as URLs 
(blue underline) in PDF output. See Default-PDF.prt. 

o Introduced Email_5in page size in Default-PDF.prt so it displays correctly in Design. 

https://www.docorigin.com/doc/index.php#AutomaticAndEmbeddedFields
https://www.docorigin.com/doc/index.php#Session
https://www.docorigin.com/doc/index.php#AutoTranslate
https://www.docorigin.com/doc/index.php#MergePDFStitching
https://www.docorigin.com/doc/index.php#MergePDFStitching
https://www.docorigin.com/doc/index.php#DesignObjectTags
https://www.docorigin.com/doc/index.php#DataFiles:JSON%20Input
https://www.docorigin.com/doc/index.php#option-inputDataType
https://www.docorigin.com/doc/index.php#SendMail
https://www.docorigin.com/doc/index.php#FileNamingConventions
https://www.docorigin.com/doc/index.php#_locale
https://docorigin.com/doc/index.php#option-embedPlainTextAsRtf


Design 
• Allow Field Initial Value to contain embedded <EOL> (use Ctrl+Enter). 
• Added AutoSave functionally for forms being edited. See menu Tools->Options for configuration 

options. The default is to save a form backup every 5 minutes. 
• If more than one user uses Design on a workstation, it is no longer necessary to run 

AllowOtherDocoriginUsers.bat/IWantToUseDocOriginToo.bat. 
• Added "Paste Without Formatting" functionality to the text editor. 

Scripting 
• Added support for -cache command line option in RunScript. 
• Allow certain non-Merge related embedded fields like date/time, session, cache, profile, env 

etc. to work outside of Merge, e.g. in _resolve() function. 
• Added _locale.setDefault() function to Merge. See 

https://www.docorigin.com/doc/index.php#_locale 
• Added _pageOrientation, _paperSize and _initialValue DOM properties. See 

https://www.docorigin.com/doc/index.php#domProperties 
• Added possibility to disable EOL conversion (\r\n->\n) in _file.readFile(). This may result in 

performance gain in some cases. See https://www.docorigin.com/doc/index.php#_file 
• Added _file.fromBase64 function. See https://www.docorigin.com/doc/index.php#_file 
• Added direct properties access to _session object (like _session.name = value). Now it is similar 

to _cache behavior. See https://www.docorigin.com/doc/index.php#_session 
• Updated <domObj>.reparent(). Arguments xOffset and yOffset are now optional and default to 

0. See https://www.docorigin.com/doc/index.php#domObj_reparent 
• Allow _document.insertPage(), i.e. <domObj> in “<domObj>.insertPage()” does not have to be 

of type page anymore. See https://docorigin.com/doc/#domObj_insertPage 
• Allow image labels to reference https[s]:-based images (via _imageName property). 

Core 
• Added possibility to inject environment variables via [!Env xxx] into command line parameters. 

See https://www.docorigin.com/doc/index.php#AutomaticAndEmbeddedFields 
• More strict $X resolution. Now if you say “Merge -trace $User.trace” you should get 

“$User.trace”. $X is not resolved if it is followed by an alpha character. This applies to both 
cmdline and _resolve. 

CsvToXml 
• Updated CsvToXml script so that it can be run standalone. 

DocOriginNotify 
• Enhanced DocOriginNotify to make file list control contain more columns and support sorting. 

MultiPage 
• Added MultiPage to DocOrigin toolset. See https://docorigin.com/doc/#MultiPage 

WebServices (1.3.3) 
• Implemented script security via Default-WsSecurity.wjs. 
• Optimized keepJobHours setting. 
• Introduced jobIdPrefix parameter for "Execute a job" calls. 
• Updated Swagger-UI and enhanced Swagger docs for REST. 

https://www.docorigin.com/doc/index.php#_locale
https://www.docorigin.com/doc/index.php#domProperties
https://www.docorigin.com/doc/index.php#_file
https://www.docorigin.com/doc/index.php#_file
https://www.docorigin.com/doc/index.php#_session
https://www.docorigin.com/doc/index.php#domObj_reparent
https://docorigin.com/doc/#domObj_insertPage
https://www.docorigin.com/doc/index.php#AutomaticAndEmbeddedFields
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• Set mime type for REST output when available. 
• Fixed /jobs/{jobId}/files/{fileName} method to support nested file path, i.e. when {fileName} is 

actually a path containing folders. 
• Added support for /jobs/{jobId}/files to accept fileName as a query parameter (as an 

alternative). 
• Return jobId if available when "Execute a job" fails. 

TaskFlow 
• TaskFlow is a powerful application that empowers DocOrigin server administrators to create, 

manage and test Jobs. From managing sample data, to creating custom tasks, TaskFlow will 
make your life easier! See https://docorigin.com/doc/index.php#TaskFlow 

https://docorigin.com/doc/index.php#TaskFlow


DocOrigin 3.1.002.12                                                               28-April-2020 

Merge: 
• Made Merge to fail if AutoMail has failed. 
• Fixed footer position calculation when footer is defined for Container. 

Design: 
• Fixed unwanted renaming of an "old" field after the "new" one is added. 

• Do Form Explorer selection update before object properties update. 

• Fixed typo in RFID tags in Default-Zebra.xatwlib. 

• Fixed justification toolbar update for labels. 

• Added modifications check in ScriptEditor so changes are not lost on ESC. 

• Fixed crash in Design when configure image rotation to angle other than 0, 90, 180, 270. 

• Disabled Format->Rotate->Other for images. 

• Fixed crash in Find Dialog in Design. 

ConvertDatToXml: 
• Fixed an infinite loop caused by unrecognized inline text control command at the end of the 

string. 

• Added autodetection of file paths among inline text control command. 



DocOrigin 3.1.002.11                                                               20-March-2020 

Merge: 
• Fixed page tabs in the html driver when there are invisible pages in the document. 
• Fixed SynthBold issue for rotated text in PostScript output. 
• Fixed a file path with a dash ('-') handling for "placeholder" tags. 

Scripting: 
• Enabled _profile.load() to do profile initialization actions immediately on call.  
• Fixed _parser.parms() to properly parse assignment characters, i.e. equals (=) or colon (:), if they 

appear in value. 

Design: 
• Fixed crash when pasting text into the first line which is a new line. 

FilterEditor: 
• Fixed crash in FilterEditor when "Delayed State Changed" action is used. 

ConvertDatToXml: 
• Fixed an infinite loop caused by inline text control command which uses newline as a delimiter.  



DocOrigin 3.1.002.10                                                               24-Dec-2019 

Design 

• Added new “Paste and Group” option when copying objects. 
• Added "Note" and "Tag" marks to unnamed objects in Form Explorer. 
• Added option to edit Output Configuration files (.prt files) to Preview dialogs. 
• Added option to save .prm or .mprm file with the merge options supplied for preview. 
• Added new setting (Tools->Options) to control the display of the output of PDFPreview or 

HtmlPreview. The output can still be displayed manually using the new Status bar PDF or Html 
buttons. The Status bar also has an Eml button that will display an email generated via the new 
_email_ fragment in the Default-Fragments library. 

• Fixed several table drawing issues. 
• Fixed shift of the horizontal rulers on zoom. 
• Fixed copy/paste of rtf text for some rare cases. 
• Added ability to supply “external tools” to the “Tools” menu option. See 

https://docorigin.com/panetalk/ExternalTools.php 

Merge 

• Added “-Rotate180” option to PCL drivers. See Default-LJ4.prt, Default-LJ4Color.prt, etc. 
• Added possibility to resolve [LabelName] in embedded fields. See 

https://docorigin.com/doc/#AutomaticAndEmbeddedFields 
• Added [!base64 FieldName] embedded field which will base64 encode the named field/label 

value. See  
https://docorigin.com/doc/#AutomaticAndEmbeddedFields 

• Added a date stamp to Subject line when autoEmail is used in Design test mode. 
• Added a blank page rendering when nothing is drawn in PDF driver. 
• Respect field/label top/bottom margins on split. See 

https://docorigin.com/doc/#Pagination 
• Fixed SynthBold issue for rotated text in PCL output. 
• Fixed monospaced font optimization in PDF for some asian fonts. 
• Fixed percentages in LegendFormat for PieChart. 
• Fixed default dithering algorithm for the case when color image is used for black and white pcl 

output on Linux. 
• Fixed several PrinterTable issues. 
• Fixed extra temp file creation when output file name used “%u”. 

FolderMonitor 

• FolderMonitor performance improvements. Now by default FolderMonitor doesn’t collect jobs 
counts statistic to send it to Folder Monitor Console. You can enable it with new “-
UpdateCounts” option. See 
https://docorigin.com/doc/#FMoption-UpdateCounts 

https://docorigin.com/panetalk/ExternalTools.php
https://docorigin.com/doc/#AutomaticAndEmbeddedFields
https://docorigin.com/doc/#AutomaticAndEmbeddedFields
https://docorigin.com/doc/#Pagination
https://docorigin.com/doc/#FMoption-UpdateCounts


Scripting 

• Added possibility for PI instructions to appear before the default <XMLData> and <Document> 
tags when using xmlFile.pi(string). See 
https://www.docorigin.com/doc/#FMJobNameDiscovery 
https://docorigin.com/doc/#XmlFile 

• Added attributes support to XmlFile methods. See 
https://docorigin.com/doc/#XmlFile 

• Added new script functions _toBase64(str), _fromBase64(str), and _file.toBase64(filename) to 
encode/decode Base64 data. See 
https://docorigin.com/doc/#_toBase64 
https://docorigin.com/doc/#_fromBase64 
https://docorigin.com/doc/#_file 

• Added _file.readIniFile(fname) function. See 
https://docorigin.com/doc/#_file_readIniFile 

• Fixed _inlineToRtf to support parsing of inline “rtf” commands when command sequences don't 
end with a point. 

• Fixed rare bug when JavaScript function parameters were results of the string operations on the 
same source string. 

SendMail 

• Added new “-encodeHTML” option to change html encoding to "8bit". See Default-
DocOriginSendMailServer.prm 

• Added new “-mailHoldFolder Hold” option to control output folder for mails on “hold”. 

ConvertDatToXml  

• Fixed parsing of inline “rtf” commands when command sequences don't end with a period. 

ConfigEditor 

• Improved config serialization to generate less diff on edit. 

Licensing 

• Added support for hostnames longer than 16 characters on Windows for licensing purposes. 

https://www.docorigin.com/doc/#FMJobNameDiscovery
https://www.docorigin.com/doc/#FMJobNameDiscovery
https://docorigin.com/doc/#XmlFile
https://docorigin.com/doc/#XmlFile
https://docorigin.com/doc/#_toBase64
https://docorigin.com/doc/#_toBase64
https://docorigin.com/doc/#_fromBase64
https://docorigin.com/doc/#_fromBase64
https://docorigin.com/doc/#_file
https://docorigin.com/doc/#_file_readIniFile


DocOrigin 3.1.002.09                                                               26-Sep-2019 

 
• Design 

o Added log viewer. See button on the status bar. 

o User may choose whether to display adjacent panes with a small gap between them or 
not, using the Design Tools>Options command. 

o Added -PDFPageMode option to PDF driver to control Acrobat navigation window. The -
PDFPageMode Merge option can be used to tell the pdf viewer (Acrobat) to optionally 
display thumbnail images of each page (-PDFPageMode UseThumbs) on startup. 

o Make "Insert Pane" menu item insert a default pane and not clone the current one. 

o Auto grow/extend all panes and groups (not just top ones) on paste or move of an 
existing object into them. 

o Remove names from non-fields. It now keeps names that start with $ or _ (not just _). 
Names, on anything that start with $_ (two chars) are considered temporary names and 
are always removed when Format->Remove names ... is selected. 

o Allow panes to grow vertically on margin change. 

o When adding text labels, fields, or tables in Design, adjust the object size to match the 
default font sizes currently defined in Format>DefaultSettings. 

o Improve displaying of symbol fonts (like Webding). 

o Paste (and move in FE) of objects and following horizontal adjustment redesigned. Now 
paste doesn't affect target container horizontally. 

o Add "*" to "Tags" and "Notes" buttons for Form and Page properties dialogs when value 
is nonempty. 

 

• Merge 
o Added PrinterTable output functionality. 

https://www.docorigin.com/doc/index.php#MergeOutput:Merge%20Output  
 

• Core 
o Prm files - allow entries to be defined via multi-line Heredoc notation. Ex:  

▪ -cache <<<xxx 

▪ address:2364 Pollock Ave, 

▪ North Gower Ontario 

https://www.docorigin.com/doc/index.php#MergeOutput:Merge%20Output


▪ xxx 



DocOrigin 3.1.002.07                                                               26-July-2019 

 
• Design: 

o Add view last log button to status bar with color coded last run status. 
o Add last used data file button to status bar. 
o Add “Edit PRT ...” buttons in Preview dialog. 
o Support multi-line options in Preview dialog. 
o PDF preview toolbar button + Ctrl key opens PDF preview dialog. 
o Do not allow to resize pane height to less than min height set. 

 
• Merge: 

o Add BarcodePostNetRatio parameter for POSTNET barcode. 
https://docorigin.com/doc/index.php#BarcodeOptions 

o New -PDFTitle "any title" command in PDF driver, if no explicit Title defined, title is set 
to the output filename. 
https://docorigin.com/doc/index.php#option-printerOptions 

o Allow profile files use * as comment at the beginning of a line. 
o Do $$X substitution recursive like $X. 

 
• Scripting: 

o Improve performance in JS DOM objects getter. 
o New _profile.getFirstSection(), _profile.getNextSection() functions. 

https://docorigin.com/doc/index.php#_profile 
o Add 3rd optional param to _run to capture and log process’ stdout and stderr. 

https://docorigin.com/doc/index.php#_run 
o _file.zip updates. 

https://docorigin.com/doc/index.php#_file_zip 
▪ Allow _file.zip to compress folders. 
▪ Make _file.zip create output file if it doesn't exist but "append" mode is used. 

o Add %v, %x, %z options to _resolve to get output file parts in Merge. 
https://docorigin.com/doc/index.php#FileNamingConventions 

 
• SendMail: 

o Add args.testMail to redirect mails to test email account. 
https://docorigin.com/doc/index.php#_sendmail 

 
• FolderMonitor: 

o Change the FMTransaction call in FolderMonitor to set -monitor and -metadata only if 
they are being used. 

 
• DocOriginCombineForms: 

o Support multiple "-in ..." occurrences in DocOriginCombineForms command line. 
 

• PDFExtract:  
o Update log levels for PDFExtract log messages. 

https://docorigin.com/doc/index.php#BarcodeOptions
https://docorigin.com/doc/index.php#option-printerOptions
https://docorigin.com/doc/index.php#_profile
https://docorigin.com/doc/index.php#_run
https://docorigin.com/doc/index.php#_file_zip
https://docorigin.com/doc/index.php#FileNamingConventions
https://docorigin.com/doc/index.php#_sendmail


DocOrigin 3.1.002.06                                                               03-May-2019 

 
• Design 

o Made Find/Replace dialog remember fields on focus lost. 
o Improved handling of conflicts in panes Overflow list if several panes share the same 

name. 
o Made "Insert->Page->..." not to clone source page script to result page. 
o Fixed calculation of available internal object space for setting up top or bottom margin. 

 

• Merge 
o Added external PDF merging functionality. See 

https://www.docorigin.com/doc/index.php#MergePDFStitching 
o Changed resources (images) search algorithm. See 

https://www.docorigin.com/doc/index.php#option-imagePath 
o Pagination 

▪ Added new pagination algorithm. See https://docorigin.com/doc/#Pagination 
▪ Made parent for columnarized panes to shrink to the tallest column. 
▪ Fixed the alignment of columnarized panes when headers/footers are used. 
▪ Fixed top/bottom margins handling for columnarized panes. 
▪ Improved performance for columnarized panes. 
▪ Made pagination algorithm to respect minimum pane height for footers and 

headers. 
▪ Fixed header pane position on "Overflows to Page" page. 

o RTF 
▪ Added new command line option “-rtfParserVersion”. For version “2” it enables 

support some of rtf paragraph formatting commands. See 
https://docorigin.com/doc/index.php#option-rtfParserVersion 

o HTML 
▪ Added border radius to output styling. 
▪ Modified HTML input checkbox/radio to position text correctly. 

o Barcodes. 
▪ Fix MaxiCode so that customers are not forced to pad Zip/Postal codes to the 

maximum 9 bytes. See https://www.docorigin.com/doc/index.php#Barcodes 
▪ Added Gs1-128 barcode support. See 

https://www.docorigin.com/doc/index.php#Barcodes 
o Consider pane's margins when stretching pane's children vertical lines. 

 

• Scripting 
o Added getObjectsByName(), getObjectsByType(), getObjectsByTag(), getPickedObjects(). 

See https://docorigin.com/doc/#domFunctions 
o Added a _prompt() function to do basic Yes/No and OK/Cancel user prompt. See 

https://www.docorigin.com/doc/index.php#_prompt 
o Added _file.zip() and _file.unzip() functions. See 

https://www.docorigin.com/doc/index.php#_file 

https://www.docorigin.com/doc/index.php#MergePDFStitching:External%20PDFs%20merging%20(initial%20release)
https://www.docorigin.com/doc/index.php#option-imagePath
https://docorigin.com/doc/#Pagination
https://docorigin.com/doc/index.php#option-rtfParserVersion
https://www.docorigin.com/doc/index.php#Barcodes
https://www.docorigin.com/doc/index.php#Barcodes
https://docorigin.com/doc/#domFunctions
https://www.docorigin.com/doc/index.php#_prompt
https://www.docorigin.com/doc/index.php#_file


o Added new DOM properties: _caption, _onSplitHeader, _onSplitFooter, 
_allowBreakBefore, _allowBreakAfter, _adjustWidth, _adjustHeight, _singleLine. See 
https://docorigin.com/doc/#domProperties 

o Extend _file.findNext to search for directories. See 
https://www.docorigin.com/doc/index.php#_file_findNext 

o Added DOM methods to any new DO object in script. 
o Allow the object name to be set to "". 
o Made reparent to update xLeft, not just yTop. 
o In _printf support 64bit ints in case of %d/x/X/D. 
o Improved readability when printing script objects. 
o Made JS garbage collection to trigger at about 1GB of memory consumption. 

 

• SendMail 
o Added “header” option to SendmailServer.prm and _sendmail() which inserts an email 

header into the output eml file. See https://docorigin.com/doc/#_sendmail 
o Updated email address validation to allow more valid chars. 
o Add message throttling. See “-maxRate” option for SendMail 

https://docorigin.com/doc/#SendMail 
 

• Other/Common 
o Add $T variable to DO binaries. Make $T resolve into DO temp folder - .../AtwTempFiles. 
o Added support of user's env vars in their $P definition. e.g.  ;[PATH]. 
o Added ConvertTxtToXml.exe. See https://www.docorigin.com/doc/index.php#filter-

ConvertTxtToXml 
o Profile handling - added multi-line values (heredocs). See 

https://www.docorigin.com/doc/index.php#_profile 

https://docorigin.com/doc/#domProperties
https://www.docorigin.com/doc/index.php#_file_findNext
https://docorigin.com/doc/#_sendmail
https://docorigin.com/doc/#SendMail
https://www.docorigin.com/doc/index.php#filter-ConvertTxtToXml
https://www.docorigin.com/doc/index.php#filter-ConvertTxtToXml
https://www.docorigin.com/doc/index.php#_profile


DocOrigin 3.1.002.04                                                         26-December-2018 

 
● Design 

○ The colors used in the Design UI are now customizable via its Tools-Screen Colors... 

dialog. 

○ Improved zoomed-in functionality for smoother operations 

○ Several small enhancements were made in the Object Tags area. 

○ Improved nudging of objects - now moves first to be on-grid, then by grid interval. 

 
● Merge 

○ Improved support of USPS-IM barcode. Handle the unusual case where the data is pre-

encoded in ADFT (four-state) format. 

○ Improved support of GS1-128 barcode. It didn’t work correctly with checksum included. 

○ PDF -textpresentation 1 improvements. Using this option will now allow font changes 

within a text line, including bold, italic, underlining, point size and typeface changes. 

(Available in PCL, PDF, and HTM output drivers only). See 

https://www.docorigin.com/doc/index.php#option-textpresentation:-textpresentation  

○ Enhanced the -imagePath command line option. It can now be used to specify a 

semicolon-separated list of folders to be searched, in sequence, when looking for an 

image file referenced in a data file. See 

https://www.docorigin.com/doc/index.php#option-imagePath:-imagePath  

○ Improved performance of the pagination process. 

○ Improved handling of fonts in synthbold case. Sometimes processing caused line widths 

to get wider. 

○ When displaying license info Merge now includes the License Type (Eval | Dev | Prod) . 

E.g. 

... 
OS type: Windows 
License Type: Eval 

○ When processing a file referencing construct such as [@fileName.ext] the -imagePath 

search path will be used to find the file. Of course -imagePath was first invented to aid 

in finding images, despite the name, we are extending that usage to also apply to these, 

usually text, file reference constructs. 

○ Added Merge command line arg "-preferImages" to be used to indicate where Merge 

should first look for an image for an image field. See 

https://www.docorigin.com/doc/index.php#option-preferImages:-preferImages  

○ When generating PCL, Merge emits resources such as fonts and images only once. In the 

case of combineDocuments=Yes the false presumption had been that there would be 

only one file output and hence those resources need never be repeated. However, it is 

possible to switch to a new output file part way through a run. That circumstance is now 

detected and any necessary resources are placed into the new output file. 

https://www.docorigin.com/doc/index.php#option-textpresentation:-textpresentation
https://www.docorigin.com/doc/index.php#option-imagePath:-imagePath
https://www.docorigin.com/doc/index.php#option-preferImages:-preferImages


 
● Scripting 

○ Improved name resolving in script    _this.objname.xxx    to find the xxx object anywhere 

in the DOM, not just in the immediate children or siblings. As Merge searches for the 

named object, it rises through the parental hierarchy. At each level it first checks the 

immediate children, then does a full descendent search of all of its children. At each 

level it always looks at all immediate children first, before descending further. If the 

search is not successful, Merge then moves up a level in the parent hierarchy and begins 

the process again. (It does not re-search, already searched paths).  

○ The DOM() and DOMValue() functions no longer anchor their search at _document but 

anchor on the <domObj> in <domObj>.DOM(“...”) or <domObj>.DOMValue(“...”).  This 

ensures that the proper occurrence of the referenced object will be returned, rather 

than always only the first occurrence. 

○ Allow getting DOM properties: _autoFormat , transparent, collate and numcopies. It was 

possible to set them but not get. See 

https://www.docorigin.com/doc/index.php#domProperties:DOM%20Properties  

○ Added _mandatory DOM Property. See 

https://www.docorigin.com/doc/index.php#domProperties:DOM%20Properties  

○ Now XmlInput throws an exception in case of a parse error. 

○ Made _os.getMergeVersion() available everywhere, not just in Merge. 

○ Added the _os.getVersion() synonym to _os.getMergeVersion(). 

○ Added DOM function getAllTags. See 

https://www.docorigin.com/doc/index.php#domObj_getAllTags:domObj.getAllTags  

○ Added DOM function relayout() to be used to force the re-laying out of an object and all 

its descendants so that the actual height of the object is returned by _height. See 

https://www.docorigin.com/doc/index.php#domObj_relayout:domObj.relayout  

 
● ConvertDatToXml 

○ Clean up any temp file created when doing a symbolset conversion.  

 
● FormConvert 

○ Typeface names found in an XDP being converted, or in xhtml strings, can be overridden 

by the usual Design Alternate Typeface registry entries. 

 
● SendMail 

○ Now the “keep” option may be passed to individual email files. See “.keep” in 

https://www.docorigin.com/doc/index.php#_sendmail:_sendmail  

○ The Default-DocOriginSendMailServer.prm no longer sets a placeholder smtpuser or 

smtppassword. There is no longer a need to override them to setup “No Authentication” 

email operation. 

 
 

https://www.docorigin.com/doc/index.php#domProperties:DOM%20Properties
https://www.docorigin.com/doc/index.php#domProperties:DOM%20Properties
https://www.docorigin.com/doc/index.php#domObj_getAllTags:domObj.getAllTags
https://www.docorigin.com/doc/index.php#domObj_relayout:domObj.relayout
https://www.docorigin.com/doc/index.php#_sendmail:_sendmail


● Other/Common 

○ Significantly improved performance when working with log files. Most noticeable in 

FolderMonitor scenarios. 

○ Added a -logSeverity command line option to limit log generation by severity level. Can 

improve performance dramatically. See 

https://www.docorigin.com/doc/index.php#option-logSeverity:-logSeverity  

○ A -clearLog command line option has been implemented. Using  -clearLog or -clearLog Y 

will empty the log before the run begins. This can be handy during dev/test. See 

https://www.docorigin.com/doc/index.php#option-clearLog:-clearLog  

○ Profile/ini handling - added macro [Define] and expansion. Common strings (often long 

“base paths”) can be defined once and used throughout the ini file. Improves 

maintainability significantly. See “Text Substitution” in 

https://www.docorigin.com/doc/index.php#_profile:_profile 

 

DocOrigin 3.1.002.03           04-October-2018 

 
Major new features: 

o Added the capability to have FolderMonitor and FolderMonitorSvc get their options 
from $O/DocOriginFolderMonitor.ini instead of from the usual associated .prm files. See 
https://www.docorigin.com/doc/#FMMultiInstance:Multiple%20Monitors 

o Support the specification and use of overflow headers and footers on the Container 
object. 

 
• Design 

o Design guidelines now extend to bottom of all panes even when panes extend below 
the bottom of the page. 

o Added “$X Folder Mapping” reference to Help menu. 
o Fixed unintentional shift of a rotated label (any angle except 0, 90, 180, 270 angle) after 

entering/quitting text edit mode. 
o Ensure “Input” tab is displayed in “Common Properties” only when picked items include 

at least one object that is marked for input. 
o Added tooltip to “Auto field” toolbar button. 

 
• Merge 

o Extended logging to report the total document count per driver. 
o Corrected the PCL font name used for rotated text.  
o Design & Merge: sample data generation adjustments. 

▪ 1) Insert random spaces in text fields (more realistic looking) 
▪ 2) For multiline fields make minimum line count  2.  
▪ 3) Fix field overflow with test data for narrow fields ‒ respect margins 

o Now use the -ImagePath option when we try to access images with a supplied path. 
o Fixed the drawing of 1D barcodes for PostScript. (The bars were too close together.) 
o Suppress the missing image file message.  

https://www.docorigin.com/doc/index.php#option-logSeverity:-logSeverity
https://www.docorigin.com/doc/index.php#option-clearLog:-clearLog
https://www.docorigin.com/doc/index.php#_profile:_profile
https://www.docorigin.com/doc/#FMMultiInstance:Multiple%20Monitors


o Avoid attempting to open the output as a printer when the file:: or run:: prefix is 
supplied. 

o Fixed PostScript and ZPL drivers to delete any created temporary TTF subset files. 
o Allow the Windows driver to use a custom paper size by setting PaperSize to 256 in the 

relevant prt file. Caveat: It is impossible to guarantee that this will be properly 
supported by all Windows printer drivers. 

o Ellipsis handling was modified to get the maximum number of characters on the line 
before the ellipsis is added. 

o The choice of ellipsis character can now also be set as an object tag, so on an object by 
object basis, not just an across-the-board -ellipsis option. 

o Our usage of the SpiderMonkey JavaScript engine has improved to the point where we 
no longer have a need for “DJ script”. -allowDjScript is now inoperative. 

o When the -textpresentation=1 option (for line, rather than word, at a time placement) 
was used on PCL output, the output was not correct if there were font changes in mid 
text value. This has been fixed. 

o We no longer turn on borders to be rendered by the PDF viewer, for PDF input fields. 
Merge will render edges per your design specification. 

o When Merging with multiple forms, the combined form result now has a .xatw 
extension, which is good for downstream operations. 

o Now use meaningful temp file name extensions. 
o Now we use unified function for creating temporary files instead of the overly 

constrained OS specific built-in functions. We construct a name based on the template: 
 "%T/{Prefix}%u.{Extension|'tmp'}". 

 
• Scripting 

o XmlInput object 
▪ Throw an exception if the file cannot be opened 
▪ .get() returns only leaf nodes, not endTag objects 
▪ A leaf node object now includes the startTag property 
▪ The endTag object has a SOM that includes itself 
▪ next(“name”) finds startTags as well as endTags 

o The _document object now supports the DOM and DomValue functions. 
o Fixed _file.errno function to return the errno value that is specific to the _file function 

just called, not some leftover errno from other processing. 
o Improved error handling for file.xxx functions. 
o Now require the DOM property name to be called _type, not just type. It's perfectly 

reasonable for a form object to be called "type". CAUTION : Make sure that none of 
your scripts in xatw files have a reference to <DOMObject>.type. If you do, replace it 
with <DOMObject>._type!!! 

o Support !! as a conditional comment in scripts. Uses a new -phase command line option. 
If -phase=p[roduction] then the !! becomes //, otherwise it becomes blank-blank. See 
https://www.docorigin.com/doc/#option-phase 

 
• ConvertDatToXml 

o Several performance improvements were made. 
o Reduced memory usage. 
o Handle ITC color commands without ending dots. 

https://www.docorigin.com/doc/#option-phase


o Fixed a problem with ^subform induced instantiation of panes that are child panes of a 
"oneChild" parent pane. 

 
• FormConvert 

o Fixed the minH and minW processing for labels and fields.  
o Rotated labels 

▪ Fixed horizontal positioning for labels rotated to 90 or 270 degrees. 
▪ Fixed any necessary shrinking of a rotated label 

o Avoided carrying forward the \u160 hard-space before and after embedded fields (these 
are introduced in the interim XDP). 

 
• FilterEditor 

o When looking for a leaf node in which to place the extracted value, check all the leaf 
nodes of the current parent before descending further down the tree. 

o Added a “Rule# n” comment into the xfilter file (should anyone ever text edit that file) 
o Augment the RULE display line with the WHEN statement. This makes it easier to select 

the rule of interest when doing maintenance. 
o Added some new debug script functions. See 

https://www.docorigin.com/doc/#FEJavascript:FilterEditor%20JavaScript 
o Added a $$SetPI() function to set a [DocOrigin] Process Instruction. 
o Made function key F5 the accelerator key for Xml Preview. 

 
• FolderMonitor 

o Don't require that the DocOrigin PI be at the very start of a data line. 
o The FolderMonitor handling of DocOrigin PIs has been enhanced. See 

https://www.docorigin.com/doc/#FMJobNameDiscovery:Job%20Name%20Discovery 
o Support Unicode data file names. 
o Added a "-JPSName" command line arg to FolderMonitor and FMTransaction. This 

provides an efficient way to supply the name of the job processing script for an instance 
of FM that always processes only one type of job. See 
https://www.docorigin.com/doc/#FMoption-JPSName 

 
• SendMail 

o Ensure log files are always saved, not just if -trace is set. 

https://www.docorigin.com/doc/#FEJavascript:FilterEditor%20JavaScript
https://www.docorigin.com/doc/#FMJobNameDiscovery:Job%20Name%20Discovery
https://www.docorigin.com/doc/#FMoption-JPSName


DocOrigin 3.1.002.02       25-June-2018 
• Design 

o Fixed font selection combo box with wrong sample text. 
o Added new event, Finalize, for Form object. Used as the very last event in the job 

processing cycle. See https://www.docorigin.com/doc/#MergeEvents:Merge%20Events 
o Pane overflow dialog improvements were made for better user experience – sorting, 

wider columns, better XDP name resolution. 
o Fixed "Text Label" text copy/paste crash. 

• Merge 
o When using multiple output configurations with a mixture of combined and single 

documents and requiring the embedding of fonts it was possible that a needed font was 
not embedded in one of the outputs. This has been fixed. 

o In the context of combining multiple forms into a document, the page n of m output can 
be on a form-by-form basis.. See 
https://docorigin.com/doc/#AutomaticAndEmbeddedFields:Auto/Embedded%20Fields  

o Added new event Finalize – the very last event in Merge processing. See 
https://www.docorigin.com/doc/#MergeEvents:Merge%20Events  

o Zebra RFID functionality was introduced. 
o Now PDF bookmarks can point to any page of a document, not just to the first page of a 

document. And more... See 
https://docorigin.com/doc/#domObj_bookmark:domObj.bookmark  

o Fixed pagination bug when a single Allow Multiple pane is repeated a huge number of 
times (Windows specific). 

o A significant performance improvement was made in pagination, most noticeable when 
paginating documents with hundreds of pages. 

o Fixed a bug in processing multiple page fillable PDFs that used repeating fields. 
• Scripting 

o Removed limitation of 1000 characters per script lines. 
o Extended XmlFile constructor. See https://docorigin.com/doc/#XmlFile:XmlFile%20Class  
o SpellOut/SpellOutCurrency functions now can handle big integers (>2147483647). 

• Setup 
o Do not delete FM/QM service on uninstall. This helps to save Windows service LogOn 

user/password on reinstall/upgrade. Will have effect only after this release is installed. 
• Sendmail 

o The mailSentFolder and mailErrorFolder settings are now treated as templates which 
have their $X and %x type elements resolved dynamically. See 
https://www.docorigin.com/doc/#FileNamingConventions:File%20Naming%20Conventi
ons  

• FolderMonitor: 
o Now both _merge() constructs: _merge("command line....") and _merge(argsObject) 

supply the applicable -monitor option to Merge. 
• Other 

o Various minor improvements were made to PDFExtract, including its new support for 
the standard -logfile option. 

https://www.docorigin.com/doc/#MergeEvents:Merge%20Events
https://docorigin.com/doc/#AutomaticAndEmbeddedFields:Auto/Embedded%20Fields
https://www.docorigin.com/doc/#MergeEvents:Merge%20Events
https://docorigin.com/doc/#domObj_bookmark:domObj.bookmark
https://docorigin.com/doc/#XmlFile:XmlFile%20Class
https://www.docorigin.com/doc/#FileNamingConventions:File%20Naming%20Conventions
https://www.docorigin.com/doc/#FileNamingConventions:File%20Naming%20Conventions


DocOrigin 3.1.002.01       19-April-2018 
• Design 

o To support users who make extensive use of Fragment libraries, *.xatwlib has been 
added to the default set of files in Design's file open dialog. 

o When saving auto generated test data files some users were accidentally overwriting 
their .xatw file. Now the test data file extension is forced to be .xml. 

o Added a new Design drawing tool ( ) that can be used to quickly add Fields to a 
design when using a Design ‘Image as Template…’ background. This enables accurate 
positioning of fields over an existing scanned image or PDF page. See 
https://www.docorigin.com/doc/#DesignImages  

o A page of a PDF file can be used as a visual template for drawing a form. 
o Added the ability to use a PDF page as a source for an image. See 

https://docorigin.com/doc/#DataFiles:PDF%20Page%20Images  
o Added Format-Object Tags… keyboard accelerator: Ctrl+T. 
o Added keyboard accelerator for Resize Text Labels to Minimum Height: Alt+Ctrl+H.  

• Merge 
o Significant Pagination speed improvements were made when using multi-column output 

with large numbers of flowed items. 
o Support templating in spooler doc names. See 

https://www.docorigin.com/doc/#option-spoolerDocName:-spoolerDocName  
o A new field type (Display as) of ‘Comb’ is now available. This creates a typical comb of 

separate boxes for each text letter. Controlled by the CombWidth property of the Field. 
o Add a TransparencyColor option to specify the background color for PNG images with 

alpha channel. This is most likely used in concert with a TransparencyMask option. 
o Provide alpha channel support for PNG images in PDF. (Note only PDF.) Disabled by 

default. See SupportAlpha option in Default-PDF.prt. 
o New -attachment command line option to attach a file to the generated PDF output. See 

https://docorigin.com/doc/#option-attachment:-attachment  
o New _printer script functions to manage PDF attachments at run-time. See 

https://docorigin.com/doc/#_printer:_printer  
o Merge image data items can now refer to PDF pages using the syntax: 

<path>pdfName.pdf?page=3&dpi=150 
o A $P folder mapping was introduced to allow users to specify a semicolon-separated 

"DO PATH" to files on their system. This facilitates easier, transportable, references to 
third party tools. See 
https://www.docorigin.com/doc/#StringSubstitutions:$X%20String%20Substitutions  

o Allow the use of printer name "*" in _printer.setActive() to activate or deactivate all 
output configurations. See https://docorigin.com/doc/#_printer:_printer  

• Sendmail 
o Support Office 365 email content line ending requirements.   

• Setup 
o Put DO/Bin in the PATH on Windows. 
o The Windows development system has been migrated to Microsoft Visual Studio 2017. 

This requires a new C-Runtime redistributable package to be installed. Setup will 
automatically check if that package is installed. 

 

https://www.docorigin.com/doc/#DesignImages
https://docorigin.com/doc/#DataFiles:PDF%20Page%20Images
https://www.docorigin.com/doc/#option-spoolerDocName:-spoolerDocName
https://docorigin.com/doc/#option-attachment:-attachment
https://docorigin.com/doc/#_printer:_printer
https://www.docorigin.com/doc/#StringSubstitutions:$X%20String%20Substitutions
https://docorigin.com/doc/#_printer:_printer


 

DocOrigin 3.1.001.26       7-February-2018 
• Design 

o Object Tag Dialog allows using a predefined choice list for tag values. Choices are 
defined in Design.prm. 

o Script Edit dialog - disable the Object Reference button when an Input event is being 
edited. 

o Fix problem of not enabling View>Script when there is script on only the Form Object. 
o Handle paste of emspace and enspace. 
o Draw Guidelines after all objects, so that the guidelines are always on top. 
o Add spinners to the element position dialogs. 
o When defining a grid, allow a specification of very fine grids, to the thousandth of a unit. 

 
• Design changes to allow creation of PDF/UA output 

o Add Tagging to selected portion of a text Label. Visual feedback in Design using colored 
background. 

o Modify the Format Hyperlink dialog to include setting of Alt Text. 
• Merge 

o PDF - add support for attaching files to meet the PDF/A3 standard.  
o Fixes to PDF/UA handling to support embedded tags within text labels, lists, and 

hyperlinks. 
o PCL - duplexing. Emit a specified backer page when there is a switch to requiring a front 

side placement. 
o Merge profile - added [@Variant] feature which can use data fields to determine which 

optional panes to use at run-time. 
o PDF size reduction via optimization of the pdf glyph width table when using a mono-

spaced font. 
o When using CombineDocuments=No ensure that the output file is available in End-of-

Document script processing. This has been the case for PDF, but is now true for PCL as 
well. 

• Sendmail 
o Add readReceipt and deliveryReceipt options to emails.  Note that recipients can disable 

these receipt requests.  
• FormConvert 

o Made changes to have <subformSet> Leaders/Trailers from an XDP to be handled by 
creating a wrapper pane and attach them as overflow headers and footers to it. 

o We now create an unnamed pane at the bottom of the container that includes a 
definition for each embedded field that is referenced but is not defined anywhere else 
in the form. 



DocOrigin 3.1.001.24      17-November-2017 
• Scripting 

o Provided read/write scripting access to the _lineSpacing property. 
o Added function _fromDOUnits to simplify units conversion. See 

http://www.docorigin.com/doc/#_fromDOUnits. 
o Added function _cache.logf() to simplify work with _cache object. See 

http://www.docorigin.com/doc/#_cache. 
o Added function _job.logf() to facilitate script development/debugging by being able to 

report the entire _job context object with simply: “_job.logf();”. See 
http://www.docorigin.com/doc/#_job. 

o Added possibility to enumerate _cache object properties using JS, like “for (var i in 
_cache)…”. 

• Merge 
o ConvertDatToXml: Don't output XML tags for fields, groups or panes that start with $. 
o Fix colored edges and GrayEdgeOption for no color output in PCL. 
o Introduce Atkinson dithering method for image dithering in PCL. Dithering method 

setting (DitheringMethod) is now available in Default-LJ4.prt. 
o Fix for PCL color logos not printing after usage of a solid white background in a prior 

image object (which was user error). 
o Log exit code text for better result understanding, not just a number. 
o Improved PDF/UA support of processing tables that overflow across pages in that when 

the PDF is read the table is treated as one unit without intervening overflow header and 
footer pane info. 

o Automatic bookmarking of objects tagged as H1, H2, H3... 
o Zebra: Updated prt files with custom Swiss font configuration examples. 

• Design 
o Improvements in line spacing settings. 
o Redesign of PDF Security dialog to make it more closely follow the Acrobat security 

dialogs. 
o If a pane that is used in a overflow header or footer spec is deleted, the overflow spec is 

updated automatically. 
o View all Tags menu item introduced. 
o Show Merge exit code name in Merge test dialog on failure. 

• FMTransaction 
o Reverted to the behaviour where if the nominated JPS name does not exist, then use 

the default JPS. Made the messaging around JPS usage clearer. 

• FilterEditor 
o If an XATW is specified for the sample XML file, FilterEditor will create the "autodata" 

XML file from the form design and use that as the sample XML. 
o Added F4 accelerator to simplify and speed up data extraction specifications. No need to 

right mouse click and use the context menu. 

• ConfigEditor 
o Avoid exposing .otf font files in the font list since Merge processes only TrueType fonts. 

 
 
 

http://www.docorigin.com/doc/#_fromDOUnits
http://www.docorigin.com/doc/#_cache
http://www.docorigin.com/doc/#_job


 
 
 
 

DocOrigin 3.1.001.23      7-September-2017 
• General 

o The Default-xxx.prm files no longer end with an @@$O/xxx.prm line. That line is 
presumed when the .prm file’s name begins with Default- and resides in the DO/Bin 
folder. This should prevent users from copying a default .prm file to override it and then 
forgetting to remove that @@$O line, thereby causing an infinite loop. 

• Scripting 
o Improve the performance of _file.readFile(), especially noticeable on very large files. 
o Fix the off-by-1 line number reported in diagnostics 
o In DJ scripting improve performance by reducing the internal global and *Temp* 

variable table as soon as possible. 
o Fix <locale>.currentDate and <locale>.currentTime in terms of defaulting all parameters. 
o _sendMail. Leading and trailing whitespace is now removed from To, Cc, Bcc, From 

options. 
o Restrict _rowCount to count only child rows or child panes. 

• Merge 
o Correct the saving of embedded data in PDF documents. 
o The effective locale is propagated throughout the form template DOM on startup. 

(Performance improvement reasons.) 
o Support faster numeric/currency formatting in the en_US locale. 
o In rtf support \fcharset186, i.e. cp1257 (e.g. Latvia). 

• Design 
o Show the locale-in-effect rather than just “(default)”. An * is also shown if the locale was 

set explicitly on that object. 
o Design’s locale is not defaulted to en_US but takes the OS value or the –locale option in 

the Design.prm file. 
o The [?] button, used to explain locale settings, is now on every dialog that shows a 

[Locale] button. 
o Correct the processing of Ctrl-arrow keys when operating on a table object 
o Allow row height reduction by property page input, not just via mouse drag 
o Initial table row height matches the default font (Arial 10pt) so .2” tall. 
o When a table is dropped on the canvas with a single click, the table height varies 

depending on whether header or footer rows were requested. I.e. the row height 
remains consistent. 

o When picking a text label object or entering a new text label the Font tab of the 
Common Properties dialog is not brought to the front. The user is in control. 

• FMTransaction 
o Be more accurate in the log messaging around job name determination and usage. 
o If a  JND script returns a name that is not found in the scriptFolder, then the job will be 

rejected, rather than running $E/Default-JobProcessing.wjs. If you really want that run, 
have your JND return “_default_”. Note that if a jobName.wjs file is not found it will try 
to find jobName.jps. 



 

DocOrigin 3.1.001.21      11-August-2017 
• Design 

o When importing an XDP, the proper name for a detected “floating field” is used in 
DocOrigin’s embedded field syntax. 

o Sometimes ConvertIFDShell (from Adobe) produces an erroneous 
layout="position" attribute on a subform. Design tries its best to cope with that. 

o When generating autodata, reduce the number of digits supplied if currency formatting 
applies. This avoids “field overflowed” warnings. 

o Disallow the use of dash and dot in field names. They would conflict with the 
interpretation of those characters in scripting. 

o Augment _system.rename() to allow for character-by-character replacement. This 
allows Start-of-Job script to fix xml that foolishly has tag names that have dash or dot in 
them. _system.rename("-.", "__", true); 

o When a preview is done and Design checks the Merge log file for any issues, Design now 
considers only log file lines that begin with the timestamp pattern. This prevents 
potential false worries about lines logged out by the user. 

o Ensure the QRCode and Maxicode barcodes are always square. 
o The ‘Collapse all panes’ menu operation takes one to a consistent opening display 

where an overview of the form’s top-level pane structure can be discerned. 

• Scripting 
o Fixed DJ .split()‘s handling of multi-character split strings. 

o Fixed _parser.delimited() to handle spaces around the chosen delimiter 
character. 

o Use of _parser will force a switch to use of SM, not DJ. 
o In Merge, the clone() function is now allowed to be used in the Start-of-Document 

event. 
o Fixed a crash in DJ scripting when, through user error, a text string was incorrectly 

assigned directly to a DOM object, (not to a property of the DOM object, but to the 
DOM object itself). 

o In SM scripting prevent a significant memory leak, especially problematic when reading 
huge files. 

o In Merge (only!), support an xhtmlToRtf() function to convert an xhtml string to its 
RTF equivalent. Note this is not any old xhtml construct but reflects that which is 
needed for importing XDPs, typically bolding etc. 

o The function names DOMValue() and DOM() are supported and preferred over the 

deprecated _DOMValue() and _DOM(). 

• FilterEditor 
o Now has a fixed initial state of *Start*. 
o Now handles accented characters in xml tag names. 
o Reports the correct line number in errors relating to the .xfilter file (was off by 

one). 

• Merge 
o For input pushbuttons the label string setting, if supplied, is now used instead of the 

object’s value. 



o The sample Web PHP files now reference C:\DocOrigin (not C:\DocOrigin3.0) and 
echo.php had a typo fixed. 

o Fixed the sample data file encoding of Sample_FunctionUsage.xml. 
o Fixed a syntax issue on Linux in the Sample_Extract example. 
o –scriptFolder is now allowed and the preferred option name, with –

scriptPath being a deprecated alternative. 
o The Merge statistics recording now supports larger numbers. 
o When using a PS2 output configuration, support the run:: output option the same as 

other output configurations do. 
o The name of the printer in the Default-PS2.prt output configuration has been changed 

to PS2 (not PostScript2). This means that the applicable printer options would use the 
PS2 prefix, e.g. –PS2CombineDocuments. 

o A return of 0 or 1 from a .wjs-based filter is considered successful. (Used to have to be 
1). 

• PCLExtract/PS2Extract 
o The option name is –docs, not –doc. Fix an otherwise misleading diagnostic to reflect 

that. 
o Handle the situation when a user specifies a document range that goes past the number 

of available documents. 
o fyi: Unlike PDFExtract, PCLExtract and PS2Extract support only one input file. 

• PDFExtract 
o On Linux, make –dumpIndex operational even when no –out is specified. The output 

goes to the console (/dev/tty). 

DocOrigin 3.1.001.20      20-June-2017 
• General 

o Adjust copyright strings to refer to Eclipse Corporation 
o *** Bring the AIX release up to the current build 
o On Windows installs warn the installer if this new install will result in a spoiler stripe 

based on an expired M&S agreement. 
o Minor fix to the sample Sample_Invoice.xml 
o The echo.php sample, for submissions from PDF, now reports “.” as the segment 

separator, not “_” (i.e. the same as for submissions from HTML). 

• Merge 
o Fix issue using _file.resolveName() at End-of-Job. 
o *** Support a “OneChild” object tag for a parent pane of multiple child panes, each 

of which are allowed to come out in any order. This is to address data streams that like 
to control the output order rather than leave it to the presentation software to define 
the layout. [Central JfMerge users often did that.] 

o Define the _parser function in Merge so it can be used inside form design scripts. 
o Fix messages that report invalid usage of a property name to report the correct property 

name. 
o *** Fix the handling of the _num property. It is not at all dependent on the locale of the 

field, but on only _system.setDecimal(). 
o Fi x the handling of property settings that inadvertently caused _raw to become "". 
o Make the setting of _document.localeName take effect. 
o Fix an Interleaved 2 of 5 barcode issue that could lead to undefined results. 



o Fix the target rectangle (the sensitive-to -click area) for rotated hyperlinks in PDF. 

• Design 
o When showing the locale settings for an object (hit the [?] button next to [Locale]) 

it now shows the effective locale taking into account inheritance from its ancestor 
objects. 

o When editing text the Shift-Home/End key combos are operative. The Undo/Redo 
accelerator keys are standardized. 

o A new license key flag can disable the use of Design in what are intended to be server-
only installs. Applies to some OEM scenarios – Merge but no Design. 

• FilterEditor 
o Allow the overlay file’s symbolset to be reset (in case of an error, or the switch to a new 

sample overlay file). 
o Use $$X (the folder where this .xfilter file is) in recording where the form, overlay, 

and sample XML files are. This makes .xfilter files more portable. 

• Scripting 
o *** Make the –debug Y/N option apply to any DocOrigin executable, not just Merge. 
o *** Support an _dlogf() convenience function. It is the equivalent of    if 

(_DEBUG) _logf(…).    So you can readily code in debug logging but have it not 

executed in production. 
o XmlFile now handles the output of arrays of objects. This is especially useful in 

handling JSON-based objects. 

• FMTransaction 
o Default its –scriptPath option to ".". This facilitates standalone testing of JND and 

JPS scripts by running FMTransaction directly. Normally, it is run via FolderMonitor, in 
which case the –scriptPath option will have been set by a .prm fle. 

• DocOriginCombineForms 
o Handle UNC form paths in the forms list. 

DocOrigin 3.1.001.19      25-May-2017 
• Merge 

o On Linux only, if –alert settings caused several emails to be issued in rapid 
succession, some email could be sent multiple times. Fixed. 

DocOrigin 3.1.001.18      18-May-2017 
• Design 

o Improvements were made to the display of Thai characters on the Design canvas. 

• Merge 
o An _templateObject property was added that allows access to the Template DOM 

from the generated Document DOM. E.g. you could detect the height of a field as 
designed as opposed to its height once it has been adjusted. 

o A fix was made to DJScript to avoid looping when a semicolon was left off of a script 
line. 

o Improvements were made in the drawing of Thai characters when using WIN output 
configurations. 



DocOrigin 3.1.001.17      1-May-2017 
• Design 

o Support a –locale option to set the default locale for the session. Known to affect the 
display of the list of known locales. 

o Avoid including empty script/calculation source from XDPs when converting to 
DocOrigin object notes. 

o Fix the handling of embedded field references in IFDs. 
o A ‘?’ button has been added next to the [Locale] buttons on the modal and modeless 

Field property dialogs. 
o Added F8 and Ctrl-F8 accelerator keys for “Merge Test…”. 

• Merge 
o Restore the needed symbolset when using “SynthBold” on text strings that mix fonts. 
o When splitting long rtf streams of text across pages, preserve blanks as you cross pages. 
o Support a –locale option to set the default locale for the whole run. 
o Support the –alert option on Linux. 
o When reporting characters used but not available in the specified font, supply the 

character in UTF8 as well as plain decimal and hex. 
o Support new script functions DOM("a.b.c") and DOMValue("a.b.c"). That is, 

be able to supply a dotted notation string and have it safely resolved. This is a reaction 
to seeing user scripts that ignore the possibility of non-existence of some optional 
panes. Referencing the children of panes that don’t exist will result in script failure. 
These functions should help you alleviate that issue. 

o <loc>.spellOut of very, very large numbers surpasses ICU’s limits. These limits are 

now checked first. 
o _printer.getOutputFile() drops any file:: prefix to make usage of the file 

name easier for users. 
o Reuse PCL font IDs once Merge moves on to the next document. 

• CombineForms 
o Handle trailing semicolons in the form list and other whitespace around the semicolons. 

 

DocOrigin 3.1.001.16      24-March-2017 
• Design 

o Added support for HTML5 audio and video controls and for help text on the field input 
dialog. 

o Dropped the unused Overflow Pg. dropdown from the Pane Properties dialog. You 
should continue to specify the page layout to overflow to, on the Page Properties dialog. 

o Allow colour choices to be specified in basic CMYK (as well as the usual RGB) 
o Added support for Design-time guidelines (construction lines). 
o CheckboxShape, CheckboxStyle, RadioButtonShape, and RadioButtonStyle 

can now be specified as object tags. Hence they are available on an object by object 
basis, not just across-the-board per chosen output configuration (.prt). 

• Merge 
o Script access provided for the audio and video controls. 



o Support a –colorSpace option to specify an alternative color profile (.icc) file. This 
feature can be used to provide color correction, if needed, for different printers and 
media. 

• PDFExtract 
o Now uses documented positive return codes. 
o Supports an unlimited number of –in  PDF file arguments. (Had been limited to 50). 

DocOrigin 3.1.001.15      10-Febuary-2017 
• Merge 

o Default-WIN now defaults the SplitSegs setting to No since native Windows 
drivers do text placement based on their own metrics. Without this there were 
sometimes surprising gaps in the middle of words. 

o Various duplexing fixes were made with respect to switching between simplex and 
duplex in a single document. Affects PDF and PS2. 

o The reparent() function allows you to set the new parent to NULL, effectively taking 
the DOM object out of the tree, but not actually deleting it. You might restore it to the 
tree later on. (Rarely used.) 

o Support strikethrough text ornamentation, per Design and per rtf input. 
o In the context of PCL, with downloaded softfonts, and custom font select sequences, a 

fix was made in terms of ‘too frequent’ symbolset selection. (It’s complicated!) 
o Support was provided for emitting wide barcode bars on TEC printers whose language 

spec does not support the requisite number of digits. (Also complicated!) 
o Added a ConvertXmlToUtf8 filter which uses and revises the encoding in the XML 

specification line to guide the conversion. 
o Namespace checking is no longer done when reading XML files. 
o Validation against an XSD is no longer done when reading XML files. 
o Provided an attribute() function to allow a scripter to get the value of an XML-

specified attribute for the given XML _data node or document DOM field node. E.g. 
<Field1 name="George">abcde</Field1> 

 
 Field1._dataSource.attribute("name") returns: "George". 
Note: Curiously, you must specify –ConvertAttributes No as otherwise 

there will not be any attributes in the XML that Merge reads. 
o Fixed a bug in <fp>.fread(n); It was not converting n properly. 
o In PS2, Merge handles the insertion of the applicable duplex DSC configuration lines 

automatically. 

• Design 
o Import of an IFD does its best to fix the incorrect conversion done by the Adobe® 

conversion utility of email addresses in text labels marked as containing embedded field 
references. E.g. someone@company.com not someone[company]com. 

o Support marking portions of text labels as strikethrough. E.g. strikethrough. 
o If a pane used as a header or footer is renamed, all references to that name are updated 

automatically. 
o ScriptEditor processes double-click differently such that underscores are accepted as 

part of a word, and a trailing blank is not included. 
o ScriptEditor offers an AutoFormat button which does proper code indentation. 
o ScriptEditor colour codes commented out lines in green. 



o Design remembers and reuses the size and location of dialogs which the user may have 
adjusted. E.g. ScriptEditor. 

 

DocOrigin 3.1.001.14      10-January-2017 
• Merge 

o Fix a crash on Linux with non-Color LJ4 when dealing with images with colour. 
o Select the overflow footer/header pane that is defined on the overflowing page. This is 

especially relevant when you are combining forms with similar structures and pane 
names. 

o Sheet count information provided in a log message. 
o Added a descendant() function to more easily detect if an optional pane exists. Use 

it! Do not blindly refer to properties or children of objects that may not even exist. 
o Ensure the _childNamed() function, and others, were defined at the _document 

level itself. 

• Multi-Merge 
o Support PCL, PDF, and PS2 (as well as HTML). 

• Design 
o Allow pages to have object tags. 

• QueueMonitor 
o Make the generated file names more finely grained than just ‘to the second’. Avoid 

overwrites. 

• Copyrights – include copyright info for the FreeType library. 

• Scripting 
o Support the _odbc object and API on Linux. (Used to be on only Windows). 

DocOrigin 3.1.001.13      24-December-2016 
• ConvertDatToXml 

o Support a  –newline c   option that provides the specification of an alternate newline 

character. 
o Support ^file commands in the input data stream. 

o When using –substitute allow \n to be used in the replacement text, so as to insert 
a newline character. 

o When transitioning after ^form or ^subform  ensure that the current pane context is 
updated. This helps in handling field names that occur in multiple subforms. 

• Design 
o Provide a right-click context menu, ‘TagAs’, to more easily accomplish PDF/UA tagging. 
o Allow the tags presented in the TagAs menu to be specified in the overrides 

Design.prm file. 

o IFD/XDP conversion: Cope with incorrect tab specification syntax in an XDP. 
o Provide sample data for input fields marked as read-only. 
o Fix the erroneous interpretation of ‘D’ as ‘Ctrl-D’ in the modeless property dialog. 

• _sendmail 



o Allow all the options used in DocOriginSendMailServer.prm to be supplied in the 
arguments to an _sendmail() call or as send options in the _email_ auto-email 
pane. E.g. you can supply smtphost and smtpport in an _sendmail() call. 

• ConfigEditor 
o Support editing of ZPL and TEC configuration files. 

• Merge 
o Correct the handling of _data references to non-existent data nodes and also correct 

the result of the typeof operator on _data nodes. 
o Correct remaining ‘edge case’ issues with word-wrapping involving leading blanks. 
o Support an _sheetCount property. 
o Support more functions that used to be available using only the SpiderMonkey 

JavaScript engine, in the DJScript JavaScript engine. 

• CombineForms 
o Support exceedingly long text label content. 

• Samples 
o Correct the data file for Sample_PurchaseOrder. 

o Correct the sample .TIF files. 
o Make XmlAttrs.wjs follow filter parameter standards. Ignore any name-spaced 

attributes. 

DocOrigin 3.1.001.12      12-November-2016 
• Merge 

o Command line options are now allowed to exceed 1,000 characters. Suggestion: You 
really should use .prm files when your options get long or complicated. 

o Merge supports _job.id and _job.datafile inside Merge scripts so as to be 
consistent with their availability in Job Name Discovery and Job Processing scripts as 
well as in RunScript scripts. 

o A fix has been made to handle file references of the format: @//server/share/…, or 
indirectly via @$X/path/name, where $X mapped to a location of the format: 
//server/share/… 

o Allow the paths and names of temporary files to be up to 4096 characters long. In some 
situations the value of the TMPDIR variable can be a quite long path. 

o Fix the application of the ChartGap option setting such that usage of the chart’s group 
area is maximized. Do use margin specifications on the group itself as desired. 

o Support new charting options: ShowXTicks, ShowYTicks, ColorColumn, and 
LegendLabel. Among other things, the colour of a bar can be chosen by the data 
array. See: Chart Options. 

o Word wrapping now removes leading blanks on “overflow” lines created by word 
wrapping. 

o A fix was made to the appendInstance function such that it handles row objects as 

well as pane objects, including being able to provide the name of the row that is to get 
another instance. 

o The DataMatrix barcode is now available from the TEC fragment library. A fix was made 
for DataMatrix barcodes on TEC label printers to be able to set the module size.   

o DocOrigin command line options are case insensitive. JavaScript is case sensitive. As a 
special case, JavaScript references to _job.command.xxxxxx properties have been 
made case insensitive. Only for command line options; don’t expect that anywhere else. 

http://www.docorigin.com/doc/index.php%23_chart_options


o ODBC support has been added to DocOrigin JavaScript. From JavaScript connect to a 
database, execute select statements, fetch rows, examine column values… See: ODBC. 

o When reading TTFs, watch for invalid characters >= 0xFFFF which seem to occur in some 
less than perfect TTFs. 

o A fix was made in handling undefined object properties in the DJ Script engine. 

o The DJ Script engine now handles references to the _data DOM. This reduces the need 
for an internal shift to using the slower SpiderMonkey engine. 

o The DJ Script engine now supports the syntax: for (var x in obj). Before it 
supported “only” for (x in obj). 

o Embedded field references, i.e. [FieldName] references, have been improved to do 
an ever expanding search so as to find the nearest, most relevant, field. Normally such 
references are to fields which occur only once but some people … 

o –showNames. This debugging aid has been around quietly for a while. You may wish to 

look at the documentation at: ShowNames 

• Design 
o An icon now appears in the Form Explorer panel next to any object that has Object Tags. 

This is very helpful when adjusting PDF/UA tags, barcode related tags, or any custom 
tags. Do use the Ctrl-G accelerator key for fast access. Hopefully, you’ve already seen 
the icon that appears when an object has been given “Notes”. 

o The area outside of the physical page extents now has a very subtle shading to help you 
know where the physical page area ends. 

o When you lasso several objects on the Design canvas, objects that are marked as: Visible 
None (_presence=”none”) are not selected. What you can’t see you can’t select by 
accident. 

• ConvertDatToXml 
o –oneChild paneName. This option has been available for a while now but you may 

want to look at the documentation for it at: Data Order 

DocOrigin 3.1.001.11      14-October-2016 
• Merge 

o Now supports rotation of images to 90° increments (also in Design of course) 
o Fixes some issues related to documents that have a mixture of simplex and duplex 

output. For PDF, if any portion of the output is duplexed then all of it is created as ready 
for duplex printing, in that blank surfaces are inserted to make that viable. This is 
necessary to accommodate having a PDF for archive and easy reprint purposes. For PCL, 
blank surfaces do not need to be inserted but the applicable switch to a new surface 
escape sequence is needed depending on simplex/duplex and page placement options. 

o Provides script access to _duplex, _pagePlacement, _localeName, 
_allowMultiple and read-only access to _originalForm. 

o Fix to an issue with spelloutCurrency() with very, very large values. 
o Fix with handling [!Date], [!Time] and [!DateTime] with non-default locales. 

o Have the clone() function take an additional argument. Also doc’ed. 
o Recognizes Microsoft printer drivers of type 3 but with attribute PRINTER_DRIVER_XPS 

as requiring the XPS_PASS flag on open so as to bypass a Microsoft presumption that 
the file format is XPS. This has been happening for Microsoft printer driver type 4 for 
quite some time now. The type 3 + flag is new. Without the XPS_PASS flag the output 
can be flushed. 

http://www.docorigin.com/doc/#_odbc
http://www.docorigin.com/doc/#option-showNames
http://www.docorigin.com/doc/#filter-ConvertDatToXml


• FolderMonitor 
o Supports running a script whenever an FM instance starts or stops. A Default-

FMScript.wjs is supplied. It can be overridden with the new –FMScript option. 

• FilterCarriageControl (and elsewhere) 
o When reading a file across the network, especially for very non-local access, a significant 

performance improvement has been made. 

• Design 
o An issue with import of a text label that is rotated and has a width of zero has been 

detected and fixed. 
o Provides UI support to set “Allow split” for text labels and groups, also provides script 

access to _allowSplit. 
o Subtle background shading to help identify the edge of the “paper” when you are 

creating boilerplate background or when creating a long layout that, at Design time, 
goes beyond the end of the paper. 

 

DocOrigin 3.1.001.09      25-September-2016 
• Merge 

o Charting: Now assumes all incoming data is in dot-as-decimal notation regardless of any 
specified locale. If it is not, then prior adjustment of the data will be required. In the 
past, automatic interpretation of incoming data per the locale of the chart proved both 
problematic and quite possibly incorrect. 

o Charting: Allow the suppression of one or more columns of data. For example an 
_loadAsArray call might load up several columns of data, but a given chart may wish 
to present only one or two of the columns in the resultant array. 

o _auto date, time and datetime had issues on Linux – fixed. 
o <domObj>.getTag and .setTag are the new, preferred, names for the old 

<domObj>.getParm and .setParm. Those older names are still supported for 

backwards compatibility purposes. 
o Using CombineDocuments=Yes with fillable form designs is not allowed. In such 

usage situations an error message is issued and the Merge run is stopped as soon as a 
second document is encountered. 

o TEC driver fixes particularly related to “synthbold”. 
o TextPresentation=4 (rasterize the text) is now available as an object tag, so on an 

object-by-object basis, rather than only across the board. Note that this is most 
particularly related to label printers. 

o When using an xfilter that specified the use of carriage control and that the input file 
was already in UTF-8 encoding then fix an erroneous file deletion. 

o HTML driver. A –scriptTools Y/N option has been defined to allow you to easily 

suppress inclusion of much JavaScript code that is not used in other than input HTML 
forms. Of course you could and can always override the entire Default-
DOHtmlTemplate.htm file. 

• Scripting 
o _sendmail now hardens the paths supplied for attachments or text/html body 

content. Hence you can use $X folder mappings in those argument values. 



o _os.type is now supported with the DJ JavaScript engine. 

• Design 
o Now preserves object tags and notes when converting between fields and labels. 
o View-All Notes is now read-only. 
o Immediately after inserting a fragment you can use Ctrl-D to duplicate that fragment. In 

general, Ctrl keys interception, while in a modeless dialog, has been improved. 
o On import of an IFD/XDP allow for different typefaces within a single text label object. 

• FilterEditor 
o Trim blanks is now trim whitespace in that it will remove all characters with codes 

between 01 and 31, e.g. including cr, lf, ff, and tab. 

• Documentation 
o Much reorganizing of the command line options such that each program has its own list 

of options that apply to it. 
o Charting: Documentation added to identify yet more options in displaying values on 

axes and legends. 
o Existence of <locale>.name function documented. 

• Miscellaneous 
o CopyDataFile has been added to the Linux install set. 
o In FolderMonitor, the “filtering out active file” message is now a trace message. It 

reflects perfectly normal operations that needn’t clutter the regular log. 
o Lines in a .prm file that start with [  are considered to be comment lines. 

DocOrigin 3.1.001.08      12-September-2016 
• Merge 

o A TEC label printer driver is now included, currently as a beta or preview release. 
o Support was added for the Pharmacode barcode, both 1-track and 2-track. This includes 

barcodes in colour. 
o In PCL, If the same image file is used in multiple places on a document *and those places 

are not the same size* we now define a new image macro for each encountered size. 
Apparently people rarely do this as it has not been reported over years of use. 

o In PCL, on a non-colour printer, rotated text might not show up if it came after the 
output of a shaded rectangle. Fixed. 

o Barcodes in HTML were not respecting the object’s margin settings. 

• Scripting 
o _loadAsArray fixed its handling of its optional second argument. This makes it easy 

to supply the names for the values being loaded from the data stream. 
o DJScript fixed for handling _fullName  for _data DOM objects. 

• ConvertDatToXml 
o Converts   \U+xxxx.     syntax in data values to the applicable Unicode characters. This 

is also reflected in the _inlineToRtf script function. 

• CopyDataFile 
o Supports  leading   –metadata Yes   parameters to cause file name, submitter, and 

submission time metadata to be appended to the copied file in a way that DocOrigin 
detects. This is typically used to copy data to a QueueMonitor-based virtual printer, or 
directly to a FolderMonitor watched folder. This information is made available to scripts 
(e.g. Job Processing Scripts) via the _metaData object. 

• FolderMonitor 



o Correct an extension renaming problem that existed when a job’s file name had two 
extensions. (aaaaaa.bbb.ccc) 

• Design 
o The Format-Rotate to a custom, non 90°, angle dialog now gets its initial focus set 

properly to ease angle entry. 
o With unusual changes in window focus, it was possible (rare) to have an object lose its 

assigned name. Fixed. 
o When you select a single text label in the Form Explorer panel and hit <Esc> you will be 

put directly into text edit mode for that text label. 

• Docs 
o The following were documented or significantly revised: _inlineToRtf, 

_os.userName, _loadAsArray, _loadAsObject, <domObj>.setTag, 
Chart Display Options, _metaData. 

o BTW: For some time now the online docs have been searchable. You may wish to note 
that there are two ways to search. If you know the “key” word and key it in, a dropdown 
list will give you the choices of where that word exists. This can be easier/quicker than 
navigating the table of contents. If you don’t know the exact word such that you don’t 
get a dropdown list, you can hit <Enter>, or click the magnifying glass, and it will provide 
a typical search results list with links and some lines of context per ‘hit’. 

 

DocOrigin 3.1.001.07      1-September-2016 
• Merge 

o Charting: Extended the DatasetNames chart display options property so as to control 
when X-axis tick marks come out for line charts. Some line charts with large numbers of 
data samples resulted in too tightly spaced tick marks. These new options allow (for 
example) only every 10th tick mark to be drawn. 

o Added a “Tall” page (50”) to the Default-HTM.prt configuration’s page size list. This has 
been added to allow the HTM output to create longer single pages rather than invoking 
Merge’s normal pagination to create multiple pages. 

o HTML driver: support an “imageURL” object tag to specify that the image should not be 
embedded but instead refer to an external location. 

o Sending mail. Put the multi-part boundary definitions within quotation marks since 
some email servers/clients cannot handle the obscure syntax that iCloud.com uses 
otherwise, and iCloud,com can’t handle simple boundary strings that should require no 
quotation marks without quotation marks. 

o Sending mail: Allow the -smtphost option to explicitly include the smtp:// (the 
default) or smtps:// protocol. Particularly useful for using 

       –smtphost smtps://smtp.gmail.com      for your email sending services. 
o Return any encountered return code rather than returning 0 (especially useful when 

using the rc =_merge() function call.) 
o In the Merge Test dialog, Design now passes along all strings entered into the “Output 

To:” box starting with prt:: or run:: without modification. This allows internet printing 
protocol destinations such as “prt:: http://169.254.15.2:631/ipp/port1” to be passed to 
Merge in its −output command line option.  

 

http://169.254.15.2:631/ipp/port1


• ConvertDatToXml 
o When converting text that might contain Central “inline” commands (e.g. \b0) try to 

avoid misinterpretation of file names with backslashes as inline commands. If the 
starting text for a field looks like a file name, leave that text alone. 

• FilterEditor 
o Support resolution of $X vars in file names. 

• MultiMerge 
o Introduced a new program that allows for multiple Merge outputs to be combined into 

one result. Currently this is explicitly for producing “Adaptive HTML” based on multiple 
views, e.g. a view for phones, and a view for tablets/screens. The output then displays 
correctly for whichever device refers to the HTML. 

• Design 
o Updated “Fundamentals of DocOrigin Design” posted in the online documentation. 
o Fix the Ctrl-arrow feature for adjusting the width or height of an object such that it still 

works when the anchored edge is on its parent’s boundary. Also prevent the width or 
height being reduced to zero. 

 

 

DocOrigin 3.1.001.06      16-August-2016 
• Updated Sample_PurchaseOrder form design. 

• Merge 
o Handle white lines and white text better in the context of non-color PCL printers 
o Restore printing system context by “calling”, not “executing”, an image macro for PCL 

printers. 
o PCL printing, at the last moment, converts a hard space (0xA0) to a normal space (0x20). 

This was done because some printers went awry in wandering off into some other 
symbolset when they encountered a hard space. 

o ZPL driver now includes the DPI setting in its version comment. 
o ZPL diver now supports the <SynthBold> option. 
o Fix made when using –PrintInDocumentOrder=Y in combination with transparent 

images. 
o Rasterized text can be used if there is no TTF available. Mostly for label printer usage 

but applies elsewhere too. 
o Rasterized text made available for HTML output as well. 
o In HTML, a fix was made for wrapping text with URLs that were preceded by multiple 

blanks. 
o When processing an embedded field reference [fieldname], if the field has been 

supplied as <fieldname/> or <fieldname></fieldname> then do replace that embedded 
reference with an empty string. It used to leave the embedded reference unchanged. 
Note that if the field does not occur at all in the data stream then the reference will 
continue to be left in, unchanged. 

o Auto email: References to embedded fields [fieldname] are now handled automatically 
in every _sendmail() argument. Also supports references to file names as in 
[@fileName]. 



o Auto email: The options string can now include html: value and text: value 
specifications. That is, you can nominate the contents of the body of your email directly 
in the options string (likely referring to an external file). 

o When using –DumpTimes you can specify a target file name rather than getting the 
default “Times.txt” name. 

• ConvertDatToXml 
o If all of the data is ^global, with no ^field data that matches any field in the form design, 

now that ^global data will be emitted. 
o The trailing newline (\n) in data values is now more consistently removed. 

• FilterEditor 
o Ensure that overlay file lines end in a newline (\n). Correct erroneous mainframe-

produced lines that end in a nul newline (\0\n) sequence. 

• Design 
o When Design loads up an object template from the relevant xml file (in …/DO/Bin) it 

often includes a reference to the Arial font. However, some .prt files (e.g. ZPL ones) 
don’t have the Arial font. Design now replaces the Arial choice with the first font 
specified in the .prt (often Zebra-0). 

o Avoid a potential crash when switching a form design from one .prt to another. 

• Scripting 
o _file.exists() now checks for more conditions to determine if a file exists or not. 
o _file.getOpenFileName() and _file.getSaveFileName() now save and restore the current 

directory so that it is not changed by the user’s browsing actions. 
o _dmessage and _message are now consistent between “SM” and “DJ” JavaScript 

engines. They are aware of a “runFromService” context and will not hang a service with 
a hidden message dialog. 

• ConfigEditor 
o In the “Print driver:” dropdown, supply ZPL as a possible driver. 
o In the DPI dropdown, supply DPI values that are relevant to ZPL printers. 

 

 

DocOrigin 3.1.001.05      30-June-2016 
• Merge 

o Emergency fix for embedding fonts when the –PDFCombineDocuments setting was No. 
o Charting: X-axis labels can now go from -90° to 90°. The handling of right-justification of 

labels that go “up” to the right has been improved. 
o Charting: A FeatureColor option has been added so that you can make specific bars of 

interest stand out with a different color. 

• Design 
o Some font specification changes to better support ultra-hi-res displays. Text was coming 

out too small in some areas. 



 

DocOrigin 3.1.001.04      26-June-2016 
• Design 

o Fix for an issue with the nudge wider/taller (Ctrl-arrow) function when the object’s 
parent had a margin. 

• Merge 
o Fix for [!Date format] on Linux. 
o Fix for Zebra output when UTF8 format is not supported (use PC850 instead). 
o _sendmail address list handling: fix issue with extra “noise” semicolons (multiple, 

leading, trailing) and spaces. 
o Fix for an image object’s transparency setting not being properly reset. 
o Charting (See http://www.docorigin.com/doc/#_chart_options) 

▪ _loadAsArray() applies the current object’s locale when interpreting the 
numerical values it reads. 

▪ _loadAsArray() provides an option to easily supply the names of the 
values, e.g. for display in the legend, external to the data being read. 

▪ X-axis labels can be sparse (e.g. every 3rd tick mark) so that labels don’t overlap. 
▪ Added options to suppress the X or Y axis display. 
▪ Added option to display the value on the bar (just as occurs for pie slices). Quite 

useful for stacked bar charts. 
▪ Added the option to display the X-axis labels at an angle from 0 to 90°. 

• PDFExtract 
o Support a  –attach <file>[;description] option so that an arbitrary file can 

be made an attachment inside the PDF. While this functionality is in PDFExtract, in usage 
it will probably be launched with _run() from inside a Merge script. 

 

DocOrigin 3.1.001.03      8-June-2016 
• Design 

o Enhancements to the Format-Object Tags… interface. Also added its Help file. 
o Correction made to container sizing when switching configurations 
o Added From: and Options elements to the _email_ fragment and its processing. 

• Scripting 
o Added a _parser.parms() function to parse name=”value” sequences. 

o In Merge, object resizing operations are now carried out in DJ script, as is the case in 
Spidermonkey scripting. 

o _sendmail accepts/prefers the –queue option, deprecates the –sendmail option. 
o _sendmail has adjusted its multi-part boundary values, beyond spec, to apparently 

appease iCloud.com email servers. 
o Eased the use of output redirection in command lines executed via _run(). 

• PDFExtract 
o Now hardens the paths of file names provided using folder mappings ($X) 
o Internals are now capable of handling different versions of PDF format. 

• Merge 

http://www.docorigin.com/doc/#_chart_options


o Fix problem with line-at-a-time (-TextPresentation=1) text justification involving 
parent object margins. 

o Now populates global fields in the overflow header rows of tables. 
o Linux has the PDF/A and PDF/UA metadata files and the color space definition file 

included in its install. 
 

DocOrigin 3.1.001.02      21-May-2016 
• Merge 

o Fix an issue with PDF/A and PDF/UA 
o Support a <domObj>.clone() script function. Use on descendants, not this or ancestors! 
o Support an _alternateBackgroundColor property 
o Skip attempts to set properties on the readonly _data DOM. 
o Allow appendInstance to apply to Rows (not just Panes) 
o Process the –debug option as intended – to enable the dmessage() function. 
o Make the lack of a bold variation of a font just an Information-level message. 
o Support a picture format object for auto-embedded fields such as [!date format] 
o Support an override $O/DocOrigin_EN.xml file wherein you can have override text and 

severity for specific messages. Also support a severity level of “Suppress” to suppress 
issuing such messages. 

• FilterEditor 
o When a maximum number of overlay lines is set, quit reading the input file when that is 

reached. 

• Design 
o Allow for some small tolerance in detecting if a vertical line is the full height of its parent 

pane. This affects the Form Verification Report. 
o When a page is deleted or renamed, references to it as an overflow page are 

automatically removed 

DocOrigin 3.1.001.01      15-May-2016 
This is a significant update, moving from 3.0 to 3.1. The default folder for new installs is DocOrigin, not 
DocOrigin3.0. That is, the version number has been removed. On Windows, the installation technology 
is such that it will default to overwriting DocOrigin3.0, unless you do a Control Panel based uninstall of 
DocOrigin first. Of course we would like you to switch to a DocOrigin folder rather than running “3.1” in 
a “3.0” folder. You have to be wary of any use of hard-coded paths that reference DocOrigin3.0. You 
should not have done that, but rather have used the standard folder mappings such as $U. Please 
review any use you may have made of hard-coded file paths. When you are ready, please switch to using 
a DocOrigin folder rather than one named DocOrigin3.0. (Of course, as always you are able to install into 
any folder name you like; we’d prefer it not be a misleading name.) 
 
fyi: (internal) The Windows GUI programs now run off of a 3.1 registry key. What you will notice is that 
your MRU list will start out empty. You should see no other effects. 
 

• Install on Windows 
o The install first uninstalls FolderMonitor and QueueMonitor. Since those facilities rely 

on DLLs that can be updated by a main DocOrigin install, an uninstall of DocOrigin 
implies the need to uninstall FolderMonitor and QueueMonitor. 



o The install creates folders $R/DO/Library, $U/Library, and $U/Output. 
o The default Start Menu group is DocOrigin (not DocOrigin3.0) 

• Fragments 
o See http://www.docorigin.com/doc/#Fragments.  
o Design now supports “fragments”. You can define fragment libraries and either link or 

embed fragments from those libraries into your form designs. 
o Design will “auto resolve” linked in fragments so that you have all the latest changes 

each time a form design is opened. 
o Merge, will optionally (you must specify –fragmentAutoresolve) reach out to your 

fragment libraries to bring in any later versions of fragments that were linked into the 
form designs. If you use that option, use caution and have a good QA process before 
updating production fragment libraries. 

• Auto Email 
o See http://www.docorigin.com/doc/#AutoEmail.  
o A fragment that is included in the delivered Default-Fragments file is a page named 

_email_. The fragment can be embedded in your form design as a non-printing page. 
You can use it at Design time to fill out all the information about an email: i.e. From, To, 
Cc, Bcc, Subject, Attachments, and Body. Without any script an email will be sent based 
on the declarative definition. The email body is an rtf text label that is automatically 
converted to HTML suitable for email clients. The email will be sent whenever the 
output document is closed, be that at end-of-document or end-of-job (the timing 
depends on the CombineDocuments setting). 

• Zebra Label Printer support 
o With this release, DocOrigin provides native Zebra Label Printer support using the ZPL 

language directly. [With appropriate Windows drivers you have always been able to 
produce output for Zebra label printers.] 

o This includes support of Zebra printer generated (as opposed to externally generated) 
barcodes. See http://www.docorigin.com/doc/#ZebraBarcodes.  

• Extended GS1 barcode support 
o With this release, data provided for GS1 barcodes that uses the standard parenthesized 

Application Identifier notation, e.g. (10), will be automatically interpreted so as to 
provide the correct function codes and also the correct human readable text. No need 
for special sequences such as “>8”. 

• More consistent file defaults and overrides 
o The DO/Bin folder had a number of files which did not follow the normal convention of 

being prefixed with Default- and thence of being able to be overridden in the normal 
way with a file in the $O ($U/Overrides) folder. The following files now follow the 
standard convention: 

▪ Default-DOpclSymbolsets.ss 
▪ Default-DOPDFScript.js 
▪ Default-DOHtmlHeader.htm 
▪ Default-DOHtmlHeader-tab.htm 
▪ Default-DOHtmlFooter.htm 
▪ Default-DOHtmlFooter-tab.htm 
▪ Default-DOHtmlTemplate.htm 
▪ Default-PDFmetadata.xml 
▪ Default-PDFmetadata-ua.xml 
▪ Default-DocOriginFilterProcessor.wjsinc 

http://www.docorigin.com/doc/#Fragments
http://www.docorigin.com/doc/#AutoEmail
http://www.docorigin.com/doc/#ZebraBarcodes


▪ Default-ColorSpace.icc 
o In the unlikely case that you have been making direct reference to the previous names 

(without the Default- prefix) such references will have to be corrected. 

• Merge 
o Fixed an issue when dealing with documents that used a large number of different 

glyphs. 
o Fixed an issue with handling the decimal character specified in _system.setDecimal(). 
o Fixed an issue where a character that occurred in only picture clauses was not added to 

the dynamically constructed font subset. 
o Output files which, likely due to some failure to open, were directed to DO/Bin are now 

directed to $U/Output. 
o For HTML input forms, fields marked readonly were not being submitted. Corrected. 
o Fixed an HTML input issue with handling the AM/PM time option 
o Fix for comparing output file names when some had a prt:: prefix and some didn’t. 
o Use the demf:: prefix to have Windows configurations generate “DocOrigin Enhanced 

Metafile” ouput. Use the file:: prefix to capture the output of some Windows OS drivers 
directly. Not all Windows OS drivers support this option. The file:: prefix when used with 
Windows output configurations is typically used for only debugging purposes. 

o (for debugging) With PDF output, a  –showNames colorName,offsetInInches   

option will write each pane name overtop of its display. It might make a mess and/or it 
might make what is coming out more easily understood from a dev/debug point of view, 
especially for support people who are unfamiliar with the form design. 

• Scripting 
o Support has been provided for script-based reading of XML files using the Xerces library 

for the underlying parsing. See http://www.docorigin.com/doc/#XmlInput.  
o Support _inlineToRtf to convert an Adobe Central (JetForm) inline string to rtf format. 

• Design 
o Fixed an issue with injecting newlines at the start of a text label that used rtf. 
o Ctrl + mouse scroll wheel can now be used to zoom in and out. 
o HTML input object tooltips were not being properly reported in the input object dialog. 
o Added Format-Align to Grid to place the selected objects on the defined grid 

boundaries. 
o Entering 4 hex “digits” and then pressing ALT-X causes that Unicode character to be 

entered. 
o Design’s Find dialog defaults to the mode of looking for text in script. 

http://www.docorigin.com/doc/#XmlInput

